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Group Policy Essentials

In this chapter, you’ll get your feet wet with the concept that is Group Policy. You’ll start to
understand conceptually what Group Policy is and how it’s created, applied, and modified, and
you’ll go through some practical examples to get at the basics.

The best news is that the essentials of Group Policy are the same in all versions of Windows 2000
onward. This includes server products (Windows 2000 Server, Windows Server 2003, and Win-
dows Server 2008) and all client versions of Windows including Windows 2000, Windows XP, and
Windows Vista.

Group Policy isn’t really a server-driven technology. As you’ll learn in depth a little later, the
magic of Group Policy happens (mostly) on the target (client) machine, say Windows XP or
Windows Vista. So, if your Active Directory Domain Controllers are a mixture of Windows
2000 and/or Windows 2003 and/or Windows Server 2008, nothing much changes. And it
doesn’t matter if your domain is in Mixed, Native, or another mode—Group Policy works
exactly the same in all of them.

4 There are some enhanced bits you get with upgraded domain types. With the
P Windows 2003 schema, you'll get something neat called WMl filters (described
in Chapter 5). And, it also should be noted that in a Windows 2008 Functional

mode domain level, the replication of the file-based part of a Group Policy
Object can be enhanced to use DFS replication instead of SYSVOL replication.

Regardless of what your server architecture is, I encourage you to read and work through the
examples in this chapter.
The last time I revised this chapter, I said the following:

When Longhorn server [Windows Server 2008] is released, the good news is
that there won’t be a lot of new stuff to learn. You already have the right book
you need until the next “big iteration” of Windows comes out.

Yikes! I was wrong. Well, kind of. I was right in one way, and wrong in another. That’s why
we have a new book! Books, actually, since there’s also a companion book to this one named
Creating the Secure Managed Desktop: Group Policy, SoftGrid, Microsoft Deployment Toolkit
and Management Tools (Sybex, 2008). Together these books give you a foundation in Group
Policy and what to do with Group Policy to make the most of it.

4~ 40
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Learn more about the companion book, including opportunities to download
P e-chapters, at www.GPanswers.com/book.

Let’s start with why [ was wrong. [ was wrong in my prediction because I didn’t know that
something big was about to happen between the last edition of the book and this edition
of the book. And that big thing is, or was, that Microsoft bought out a company named
DesktopStandard and integrated its technology into the Group Policy ecosystem. That means
there’s more to love (see Chapters 10 and 12).

But I was also right. That is, the essentials of Group Policy didn’t change. The stuff people
learned years ago is still as valid today as it ever was.

So, in this chapter, there are not a lot of Windows Server 2008—specific updates. That’s
because this chapter focuses on essentials, and most of the new “essentials” stuff that comes
with Windows Server 2008 could be categorized as extras or light updates.

But then there are the features that came out of the DesktopStandard acquisition. They’re
definitely more than just “extras.” It’s like a new rocket turbo-boost! In a nutshell, Windows
Server 2008 (and an available add-on for Windows XP, Windows Vista, and Windows Server
2003) increases Group Policy’s reach immensely. Additionally, Microsoft added a new way to
add change control management around Group Policy creation and deployment. Again, for
more information on these new features, stay tuned for Chapters 10 and 12.

So, let’s get started and talk about the essentials.

Getting Ready to Use This Book

This book is full of examples. And to work through these examples, 'm going to suggest a sample
test lab for you to create. It’s pretty simple really, but in its simplicity we’ll be able to work though
dozens of real-world examples to see how things work. Here are the computers you need to set up

and what I suggest you name them (if you want to work through the examples with me in the book):

DCO1.corp.com This is your Active Directory Domain Controller. It can be a Windows 2000
Server, Windows Server 2003, or Windows Server 2008 Domain Controller. For this book, I’ll
assume you’ve loaded Windows Server 2008 on this computer and that you’ll create a domain
called Corp.com.

In real life you would have multiple Domain Controllers in the domain. But here in the test lab,
it’ll be okay if you just have one.

I’ll refer to this machine as DCO1 in the book. We’ll also use DCO1 as a file server and software
distribution server and for a lot of other roles we really shouldn’t. That’s so you can work
though lots of examples without bringing up lots of servers.

XPPRO1.corp.com This is some user’s Windows XP machine and it’s joined to the domain
Corp.com. I’ll assume you’ve loaded Windows XP’s SP2 (though SP3 might be available by the
time you read this). Sometimes it’ll be a Sales computer, other times a Marketing computer, and
other times a Nursing computer. To use this machine as such, just move the computer account
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around in Active Directory when the time comes. You’ll see what I mean. I’ll refer to this
machine as XPPRO1 in the book.

Vistal.corp.com This is some user’s Windows Vista machine and it’s joined to the domain
Corp.com. Ill refer to this machine as VISTAT1 in the book. Like XPPRO1, this machine will
move around a lot to help us “play pretend” when the times arise. Windows XP works a little
differently than Vista, so having both a Vista machine and a Windows XP machine in your
environment will be good for testing.

Vistamanagement.corp.com This machine is yours—the IT pro who runs the show. You
could manage Active Directory from anywhere on your network, but you’re going to do it
from here. This is the machine you’ll use to run the tools you need to manage both Active
Directory and Group Policy. I'll refer to this machine as VISTAMANAGEMENT. As the
name implies, you’ll run Windows Vista from this machine.

Figure 1.1 shows a diagram of what our test network should look like if you want to
follow along.

You can build your test lab with real machines or with virtual hardware. | use
P VMware Workstation (for-a-fee tool) and VMware Server (free tool) for my test-
ing. However, Microsoft’s tools, like Virtual Server 2005 and Virtual PC 2007
(both free), are great choices as well. That way, if you don’t have a bunch of
extra servers and desktops around, you can follow along with all the examples.

FIGURE 1.1 Here's the configuration you’ll need for the test lab in this book. Note that
the Domain Controller can be 2000 or above, but 2008 is preferred to allow you to work through
all the examples in this book.

Your machine—the
Administrators who
control Group Policy

VISTAMANAGEMENT
vistamanagement.corp.com

Some user’s
machine. Could be
Sales, Marketing, etc.

VISTAT \

vistal.corp.com
Some user’s

machine. Could be
Sales, Marketing, etc.

Active Directory Domain
Controllers of any kind
(Windows 2000 and above)

XPPRO1
xpproi.corp.com

corp.com
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L Because Group Policy can be so all-encompassing, it is highly recommended
ING that you try the examples in a test lab environment first before making these

changes for real in your production environment.

Note that from time to time I might refer to some machine that isn’t here in the suggested
test lab, just to illustrate a point. However, this is the minimum configuration you’ll need to
get the most out the book.

Some Group Policy History

If you’ve done any work at all with Group Policy and Active Directory before Windows Vista came
out, you're likely familiar with the usual Group Policy interface, which was “in the box.” Microsoft
then went on to provide the free downloadable tool called the GPMC, or Group Policy Manage-
ment Console. The GPMC is an add-on for Windows XP (or Windows Server 2003) machines to
make the task of managing Group Policy easier. Windows Vista comes with the GPMC preloaded,
so there’s nothing to download. And—you already know this, but it's good to repeat anyway —you
can manage your entire Active Directory from any computer on your network. Therefore, for the
majority of tasks in this book, we're going to be using our Windows Vista machine (named VIS-
TAMANAGEMENT) to perform the majority of Active Directory and Group Policy tasks.

So the goal of the GPMC is to give us an updated, refreshing way to view and manage Group
Policy; indeed, this tool enables us to view and manage Group Policy the way it was meant to
be viewed and managed. The new GPMC interface provides a one-stop shop for managing
nearly all aspects of Group Policy in your Active Directory.

With the GPMC tool, it doesn’t matter if your entire Active Directory (or individual domains)
has Windows 2000, Windows 2003, or Windows Server 2008 Domain Controllers. And it
doesn’t matter what kind of Windows clients you have (from Windows 2000 onward). It just
matters that you have Active Directory.

However, one thing you'll quickly learn here and in future chapters is that you’ll want to create
and edit everything surrounding Group Policy using newer operating systems, like Windows
Vista and Windows Server 2008.

And it's free for downloading if your management station machine is the following:
=  Windows 2003

. Windows XP

And, here’s something strange:

=  The GPMCisinthe box for Windows Vista RTM (in other words, it ships from the factory,
in the box).

%
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Ll But the GPMC gets removed when you install Windows Vista + SP1.

= And it's available as a free GPMC 2.0 download for Windows Vista + SP1 in what’s known
as the Remote Server Administration (RSAT) package.

. But it's also already in the box for Windows Server 2008.

Confused? You won’t be. | talk more about how this wacky situation came to be at the begin-
ning of Chapter 3 where we talk more about the GPMC 2.0.

Stay tuned, dear reader. We'll get to that exciting new and free stuff right away in this first chapter.
| don’t want to keep you in suspense for too long.

Getting Started with Group Policy

Group Policy is a big, big place. And you need a road map. Let’s try to get a firm understanding
of what we’re about to be looking at for the next several hundred pages.

Group Policy Entities and Policy Settings

Every Group Policy contains two halves: a User half and a Computer half. These two halves
are properly called nodes, though sometimes they’re just referred to as either the User half and
the Computer half or the User branch and the Computer branch.

A sample Group Policy with both the Computer Configuration and User Configuration

nodes can be seen in Figure 1.2. Don’t worry, we’ll show you how to get there in just a second.

Group Policy Object Editor vs. Group Policy Management Editor

The screen that enables us to actually manage the Group Policy itself goes by two names,
depending on the revision of the editing tools and the situation in which the tools are being used.

Confused? You can safely ignore this if you're just getting started with Group Policy; it's just
here for completeness anyway.

In short, here’s the scoop:

= The editor will always be named Group Policy Object Editor when the GPMC edition is 1.0
(download for Windows XP for 2003) or 1.5 (built into the shipping version of Windows Vista).

= The editor will be named Local Group Policy Object Editor or Group Policy Object Editor
when you're editing local GPOs on Windows Vista or Windows Server 2008.

%
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. The editor will be named Group Policy Management Editor when you're editing Active
Directory GPOs using the GPMC 2.0 (either built into Windows Server 2008 or when using
Windows Vista + SP1 + GPMC 2.0 within the RSAT download).

Butinthe end, it doesn’t really matter. For the remainder of this book, I'll assume you're using
the updated tools and we'll mostly be editing Active Directory GPOs. So, appropriately, I'll call
itthe Group Policy Management Editor (GPME). However, if | slip up and say the GPOE (Group
Policy Object Editor), you'll still know what | mean.

The first level under both the User and the Computer nodes contains Software Settings,
Windows Settings, and Administrative Templates. If we dive down into the Administrative
Templates of the Computer node, underneath we discover additional levels of Windows Com-
ponents, System, Network, and Printers. Likewise, if we dive down into the Administrative
Templates of the User node, we see some of the same folders plus some additional ones, such
as Shared Folders, Desktop, and Start Menu and Taskbar.

In both the User and Computer halves, you’ll see that policy settings are hierarchical, like
a directory structure. Similar policy settings are grouped together for easy location. That’s the
idea anyway; though, admittedly, sometimes locating the specific policy you want can prove
to be a challenge.

When manipulating policy settings, you can choose to set either computer policy settings or
user policy settings (or both!). You’ll see examples of this shortly. (See the section “Updated
GPMC Filters” in Chapter 3 for tricks on how to minimize the effort of finding the policy set-
ting you want.)

‘)/ Most policy settings are not found in both nodes. However, there are a few that

dTE overlap. In that case, if the computer policy setting is different from the user
policy setting, the computer policy setting generally overrides the user policy
setting. But to be sure, check the Explain text associated with the policy setting.

Wait... | Don’t Get It. What Do the User and Computer Nodes Do?

One of the key issues that new Group Policy administrators struggle with is, What the heck is
the difference between the Computer and User nodes?

Imagine that you had a combination store: Dog Treats (for dogs) and Candy Treats (for kids).
That's right, it's a strange little store with seemingly two types of incompatible foods under
the same roof. You wouldn’t feed the kids dog treats (they’d spit them out and ignore the
treat), and you wouldn’t feed a dog the kids’ candy (because the dogs would spit out the sour
candy and ignore the treat).
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That's the same thing that happens here. Sure, it looks tempting. There are lots of treats on
both sides of the store, but only one type of customer will accept each type of treat.

So, in practical terms, the Computer node (the first part of the policy) contains policy settings
that are only relevant for computers. That is, if there’s a GPO that contains computer-side set-
tings and it “hits” a computer, these settings will take effect. These computer-side settings
could be items like Startup Scripts, Shutdown Scripts, and how the local firewall should be
configured. Think of this as every setting relevant to the computer itself—no matter who is
logged on at that moment.

The User node (the second part of the policy) contains policy settings that are relevant only
for users. Again, if there’s a GPO that contains user-side settings and it “hits” a user, these set-
tings will take effect for that user. These user-side items only make sense on a per-user basis,
like Logon Scripts, Logoff Scripts, availability of the Control Panel, and lots more. Think of this
as every setting relevant to the currently logged-on user—and these settings will follow the
user to every machine they pop on to.

Feeding users dog treats, er, computer settings doesn’t work. Same thing with feeding
computers user-side settings. When a GPO hits user objects with computer policy settings
or computer objects with user policy settings, it simply will not do anything. You'll just sit
there and scratch your head and wonder why it doesn’t work. But it’s not that it's not work-
ing; this is how it’s designed.

Computer settings are for computer objects, and User settings are for user objects. If this is
bad news for you, then there is an advanced technique called loopback processing that can
help you out. Look for more information on loopback processing in Chapter 5.

The 18 (Original) Categories of Group Policy

In this section, you’ll learn how to gain access to the interface, which will let you start config-
uring these categories.

Now, as you’re following along working through these examples (or you read Table 1.1
and want to get started right away), you might start to think to yourself, “Jeremy’s screen
shots don’t look like what I have on my screen.” There’s an answer for that.

If you’re already using Windows XP, Windows Vista, or Windows Server 2003 as the place
you manage Group Policy, your screens are going to look different than mine.

That’s because something big and new is ready for you to start using. But you only get it
if you can manage your Group Policy world from Windows Server 2008 or from a Windows
Vista + SP1 machine with a set of tools called the RSAT tools installed. I'll show you how to
do this in the section “Implementing the GPMC on Your Management Station” coming up a
little later in this chapter, so don’t worry about it for now.

When you start using Windows Server 2008 (or Windows Vista + SP1 + RSAT), the Com-
puter Configuration and User Configuration parts of the Group Policy Objects are split into
two additional subnodes: Policies and Preferences.

- @
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Local policies are not split into two subnodes though—that is because the Preferences node
is only available within Active Directory GPOs.

-
=

In this book, you’ll learn about the 18 major categories of Group Policy. Here’s a table that
should be helpful if you’re looking to get started working right away with a category. Again,
your Group Policy editor might not show the Policies nodes unless you’re using the GPMC 2.0
and you’re editing an Active Directory GPO.

So, if you're missing the Policies and Preferences nodes within User Config-
uration and Computer Configuration right now, don’t panic. You'll learn how
to get those nodes introduced.

TABLE 1.1 The 18 Major Categories of Group Policy
Which Operating Where to Find
Group Policy Where in Group Systems Information in
Category Policy Interface  Support It the Book Notes

Administrative
Templates (also
known as Regis-
try Settings)

Security Settings

Wired Network
(802.3) Settings

Wireless Net-
work (802.11)
Settings

User or Com-
puter > Policies >
Administrative
Templates

Computer or
User Configura-
tion > Policies »
Windows Set-
tings » Security
Settings

Computer Con-
figuration » Poli-
cies » Windows
Settings > Secu-
rity Settings >
Wired Network
(IEEE 802.3)
Policies

Computer Con-
figuration > Poli-
cies » Windows
Settings > Secu-
rity Settings »
Wireless Net-
work (IEEE
802.11) Policies

Windows 2000+

Windows 2000+

Windows Vista
only

Windows XP
and Windows
Vista (set inde-
pendently)

Many examples
throughout the
book

Chapters 8 and 9

Chapter 9

Chapter 9

Be sure to read
Chapter 9 before
attemptingtouse
these settings.

Be sure to read
Chapter 9 before
attemptingtouse
these settings for
Windows Vista.

+/@
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TABLE 1.1 The 18 Major Categories of Group Policy (continued)
Which Operating Where to Find

Group Policy Where in Group Systems Information in
Category Policy Interface = Support It the Book Notes
Scripts Computer Con-  Windows 2000+ Chapter 8

figuration > Poli-

cies » Windows

Settings >

Scripts (Startup/

Shutdown) and

User Configura-

tion > Policies »

Windows Set-

tings > Script

(Logon/Logoff)
RIS (Remote We cover RIS’s RIS has been
Installation upgrade called deprecated in
Services) WDSinChapter1 lieu of Windows

ofthe companion
book, Creating
the Secure Man-
aged Desktop:
Group Policy,
SoftGrid,
Microsoft
Deployment
Toolkit and Man-
agement Tools.

Deployment Ser-
vices (WDS).
However, WDS
can run in Mixed
mode where it
can emulate a
RIS setup. These
settings are not
available in Win-
dows Vista and
are only accessi-
ble when you're
editing GPOs on
previous ver-
sions of Win-
dows. If youwant
to specifically
control RIS, it is
suggested you
manage the
machine directly,
without GPOs. |
won't cover the
RIS aspects in
this book. For RIS
information, see
previous editions
of the book.
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TABLE 1.1

The 18 Major Categories of Group Policy (continued)

Which Operating

Where to Find

Group Policy Where in Group Systems Information in
Category Policy Interface  Support It the Book Notes
Group Policy Computer or Windows 2000+ | cover this topic
Software Instal-  User Configura- in Chapter 4 of
lation (also tion > Policies » the companion
known as Software book.
Application Settings
Management)
Folder User Configura- Windows 2000+; | cover this topic
Redirection tion > Policies » some additional in Chapter 3 of
Windows Set- options for Win- the companion
tings > Folder dows XP; many  book.
Redirection additional
options for Win-
dows Vista
Disk Quotas Computer Windows 2000+ |don’t coverthat There is a brief
Configuration » subject in this article on disk
Policies » book. That con- quotas here:
Administrative tent has been http://support
Templates » removed to make .microsoft.com/

Encrypted Data
Recovery Agents
(EFS Recovery
Policy)

Internet Explorer
Maintenance

System > Disk
Quotas

Computer Con-
figuration > Poli-
cies » Windows
Settings > Secu-
rity Settings »
Public Key Poli-
cies » Encrypting
File System

User Configura-
tion > Policies »
Windows Set-
tings > Internet
Explorer
Maintenance

Windows 2000+

Windows 2000+

room for other
material. Disk
Quotas have been
covered in previ-
ous editions.

Chapter 8

Chapter 9

kb/183322. There
is another article
here: http://
tinyurl.com/
35mvny.

+/@
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TABLE 1.1 The 18 Major Categories of Group Policy (continued)
Which Operating Where to Find

Group Policy Where in Group Systems Information in
Category Policy Interface  Support It the Book Notes
Software Restric- Computer or Windows XP+ Chapter 8
tion Policies User » Policies »

Windows Set-

tings » Security

Settings » Soft-

ware Restriction

Policies
Quality of Computer or Windows XP+; Not covered You can start
Service (QoS) User Configura-  Policy-based your Windows
Packet Sched- tion » Policies » QoS is Vista- Vista QoS jour-
uler and Policy- Windows Set- only. ney here: http://
Based QoS tings » Policy- tinyurl.com/

based QoS yxg1pp.
IPSec (IP Secu- In XP: Computer  Windows 2000+ Chapter 9 In Vista, this is

rity) Policies

Windows Search

Deployed Printer
Connections

Configuration »
Policies » Win-
dows Settings >
Security
Settings >

IP Security
Policies

Computer
Configuration »
Policies »
Administrative
Templates >
Windows Com-
ponents >
Search

Computer or
User Configura-
tion > Policies »
Windows Set-
tings > Deployed
Printers

Windows Vista

Technically,
Vista only;
workaround
available for Win-
dows 2000+

%

Not covered

| cover this topic
in Chapter 9 of
the companion

book.

now part of the
Windows Fire-
wall with
Advanced Secu-
rity section
located under
Computer Con-
figuration > Poli-
cies » Windows
Settings » Secu-
rity Settings.

http://

www.microsoft
.com/windows/
desktopsearch
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TABLE 1.1 The 18 Major Categories of Group Policy (continued)

Which Operating Where to Find

Group Policy Where in Group Systems Information in
Category Policy Interface  Support It the Book Notes
Offline Files Computer or Different Group  We cover this

User Configura-  Policy “moving  topicin Chapter3
tion > Policies » parts” to make ofthe companion
Administrative this technology = book.
Templates » Net- work in Vista and
work > Offline Windows Server
Files 2008 than in pre-

vious operating

systems; feature

available in Win-

dows 2000+
Group Policy Computer or Group Policy Chapter 10 This is one of
Preference User Configura-  Preference the big things
Extensions tion > Prefer- Extensions built Microsoft got
ences (not in to Windows when it bought
available in local Server 2008 but out DesktopStan-
policies, only are an additional dard. These used
domain policies) download and to be called Policy
installation for Maker Standard
Windows XP and Edition and
Windows Vista; PolicyMaker
not supported on Share Manager.
Windows 2000
machines

Group Policy is a twofold idea. First, without an Active Directory, there’s one and only one
Group Policy available, and that lives on the local Windows XP or Windows 2000 workstation
(note that this changes in Windows Vista, and technically in Windows Server 2008, but we’ll dis-
cuss that later). Officially, this is called a local policy, but it still resides under the umbrella of the
concept of Group Policy. Later, once Active Directory is available, the nonlocal (or, as they’re
sometimes called, domain-based or Active Directory-based) Group Policy Objects come into
play, as you’ll see later. Let’s get started and explore both options.

)’ While you're plunking around inside the Group Policy Object Editor (also

;@TE known as the Group Policy Management Editor), you'll see lots of policy set-
tings that are geared toward Windows 2000, Windows XP, Windows Vista,
Windows 2003, and/or Windows Server 2008. Some are only for Windows
Vista, and others are only for Windows 2003, and so on. If you happen to
apply a policy setting to a system that isn’t listed, the policy setting is simply
ignored. For instance, policy settings described as working for Windows XP
will not typically work on Windows 2000 machines. Each policy setting has a
“Supported on” field that should be consulted to know which operating sys-
tems can embrace which policy setting.

- @
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Understanding Local Group Policy

Before we officially dive into what is specifically contained inside this magic of Group Policy
or how Group Policy is applied when Active Directory is involved, you might be curious to see
exactly what your interaction with Local Group Policy might look like.

Local Group Policy is best used when Active Directory isn’t available, say either in a NetWare
environment or when you have a gaggle of machines that simply aren’t connected to a domain.

Local Group Policy is different for Windows Vista versus the other Windows operating sys-
tems. Let’s explore Local Group Policy on pre-Vista machines first and then move on to the
Vista-specific features.

Local Group Policy on Pre-Vista Computers

The most expeditious way to edit the local Group Policy on a machine is to click Start » Run
and type in GPEDIT.MSC. This pops up the Local Computer Policy Editor.

You are now exploring the Local Group Policy of this Windows XP workstation. Local
Group Policy is unique to each specific machine. To see how a Local Group Policy applies, drill
down through the User Configuration » Administrative Templates > System > Ctrl+Alt+Del
Options and select Remove Lock Computer as seen in Figure 1.2. Once it’s selected, click
Enabled and select OK.

FIGURE 1.2 You can edit the Local Group Policy using the Local Group Policy Editor.
(GPEDIT.MSC)
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[#-[_] Desktop while locked, the dasktop is hidden and | (O Disabled
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When you do, within a few seconds you should see that if you press Ctrl+Alt+Del, the Lock
Computer option is unavailable.

To revert the change, simply reselect Remove Lock Computer and select Not Configured.
This reverts the change back to the way the operating system works by default.

‘)/ You can think of Local Group Policy as a way to perform decentralized admin-
dTE istration. A bit later, when we explore Group Policy with Active Directory,

we'll saunter into centralized administration.

This Local Group Policy affects everyone who logs onto this machine—including normal
users and administrators. Be careful when making settings here; you can temporarily lock
yourself out of some useful functions. For instance, frequently administrators want to remove
Run from the Start menu for Windows XP machines. Then, the first time they themselves want
to go to a command prompt, they can’t choose Start > Run. It’s just gone!

4 To get that Run command back, you’ll have to click the MMC. exe icon in
P Explorer (or via command line/batch file) and manually load the Group Policy
Snap-in.

As I stated in the introduction, most of the settings we’ll explore in this book are available
to workstations or servers that aren’t joined to an Active Directory domain. However, many
functions, like Folder Redirection settings (discussed in the companion book), the Software
Distribution settings (also discussed in the companion book), and others are not available to
stand-alone machines without Active Directory present.

é You can point toward other computers by using the syntax gpedit.msc /
P gpcomputer: "targetmachine" or gpedit.msc /gpcomputer: "targetmachine
.domain.com"; the machine name must be in quotes.

Local Group Policy on Vista and Windows
Server 2008 Computers

It’s true that you can also type GPEDIT.MSC at the Vista command prompt and get the
same Local Computer Policy Editor you just saw in Windows XP. However, Windows
Vista takes Local Group Policy to the next level.

Remember how, not more than three paragraphs ago, I stated this:

This Local Group Policy affects everyone who logs onto this machine—
including normal users and administrators. Be careful when making settings
here; you can temporarily lock yourself out of some useful functions.

True: for pre-Vista machines. On Vista, the superpower is that you can decide who gets what
settings at a local level. This feature is called Multiple Local GPOs, or MLGPOs for short.

- @
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This is most often handy when you want your users to get one gaggle of settings (that
is, desktop restrictions) but you want to ensure that your access is unfettered for day-to-day
administration.

Now, in these examples, we’re going to use Windows Vista. But, this same feature is avail-
able on Windows Server 2008. It’s just not all that likely you’ll end up using it on a Windows
Server 2008 server.

Understanding Multiple Local GPOs

The best way to understand MLGPOs is by thinking of the end product. That is, when we’re
done, we want our users to embrace some settings, and we’ll want us (administrators) to
potentially embrace some settings. Or, perhaps you want just one specific user to embrace a
particular combination of settings.

When you type GPEDIT.MSC at a command prompt, it’s just as if you did it on Windows XP:
you’re affecting all users—mere mortals and administrators.

However, with just a little bit of extra knowledge you can tap into one of Vista’s “secret
features.” That is, Windows Vista actually has three “layers” that can be leveraged to ensure
that some settings affect regular users and other settings affect you (the administrator).

Let’s be sure to understand all three layers before we get too gung-ho and try it out. When
MLGPOs are processed, Windows Vista checks to see if the layer is being used and if that layer
is supposed to apply to that user.

Layer 1 (lowest priority) The Local Computer Policy. You create this by running GPEDIT.MSC.

= The settings you make on the Computer Configuration side are guaranteed to affect all
users on this computer (including administrators).

= The settings you make on the User Configuration side may be trumped by Layer 2 or
Layer 3 (see below).

Layer 2 (next highest priority) Is the user a mere-mortal user or a local administrator? (One
account cannot be both.) This layer cannot contain Computer Configuration settings.

Layer 3 (most specific) AmIa specific user who is being dictated a specific policy? This layer
cannot contain computer configuration settings.

You can see this graphically laid out in Figure 1.3.
If there are no conflicts among the levels, the effect is additive. For instance, let’s imagine
the following;:

= Layer 1 (the Local Computer Policy level): The wish is to Remove Lock Computer from
the Ctrl+Alt+Del area.

*  Then, at Layer 2: We say “All local users” will have “Search” gone from the Start menu.
= Then, at Layer 3: We say Fred, a local user, will be denied access to the Control Panel.

The result for Fred will be the sum total of all edicts at all layers.

But what if there’s a conflict between the levels? In that case, the layer that’s “closest to the
user” wins (also known as “Last Writer Wins”). So, if at the Local Computer Policy the wish
is to Remove Lock Computer from the Ctrl+Alt+Del area, but that area is expressly granted
to Sally, a local user on that machine, Sally will still be able to use the Lock command. That’s

%




%% é 75894c01.fm Page 16 Sunday, April 13,2008 2:13 PM

16 Chapter 1 = Group Policy Essentials

because we’re saying that she is expressly granted the right at Layer 3, which “wins” over
Layers 1 and 2.

Trying Out Multiple Local GPOs on Windows Vista

Just typing GPEDIT.MSC at the Vista Start Search prompt doesn’t give you the magical “lay-
ering” superpower. Indeed, just typing GPEDIT.MSC performs the exact same function as it did
in Windows XP. That is, every edit you make while you run the Local Computer Policy affects
all users logged onto the machine.

FIGURE 1.3 A block diagram of how Multiple Local GPOs (MLGPOs) are applied to
a system

Local computer policy

Computer side
(affects everyone)

f Layer 2 ) H

User side

Is the user a Is the user a member of the
regular local user? Local Administrators group?
User side Computer User side Computer
side side

User specific ]

—

Users’ total Local Group Policy

Computer

User side Sk
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To tell Vista you want to edit one of the layers (as just described), you need to load the
Group Policy Object Editor by hand. We’ll do this on VISTAL.
On VISTAL1, to load the Group Policy Object Editor by hand, follow these steps:

1. Click Start, and then in the Start Search box (which will run things), type MMC. A
“naked” MMC appears. Note that you will have to approve the User Access Control
(UAC) message (UAC is discussed in detail in Chapter 9).

2. From the File menu, choose Add/Remove Snap-in to open the Add/Remove Snap-in
dialog box.

3. Locate and select the Group Policy Object Editor Snap-in and click Add (don’t choose the
Group Policy Management Snap-in, if present—that’s the GPMC that we’ll use a bit later).

4. At the “Select Group Policy Object” screen, note that the default Local Computer Policy
is selected. Click Browse.

5. The “Browse for a Group Policy Object” dialog appears. Select the Users tab and select
the layer you want. That is, you can pick Non-Administrators or Administrators, or click
a specific user, or the Administrator account as seen in Figure 1.4.

In the Group Policy Object Exists column in the Users tab, you can also tell
P whether or not a local GPO layer is being used.

At the “Select a Group Policy Object” dialog, click Finish.
At the “Add or Remove Snap-ins” dialog, click OK.

You should now be able to edit that layer of the local GPO. For instance, Figure 1.5 shows
that Pve chosen to edit the Non-Administrators portion of the GPO (which is on level 2).

To edit additional or other layers of the local GPO, repeat the previous steps.

Here’s an important point that bears repeating: Layers 2 and 3 of the MLGPO cannot con-
tain computer settings. That’s why in Figure 1.5 you simply don’t see them—they’re not there.
If you want to introduce a computer-side setting that affects everyone on the machine, just fire
up GPEDIT.MSC and you’ll be off and running. That’s Layer 1, and it affects everyone.

Local GPOs Final Thoughts

You can think of Local Group Policy as a way to perform desktop management in a decen-
tralized way. That is, you’re still running around, more or less, from machine to machine
where you want to set the Local Group Policy.

The other strategy is a centralized approach. Centralized Group Policy administration
works only in conjunction with Active Directory and is the main focus of this book.

Multiple Local Group Policy” from Microsoft. At last check, the URL was

é/ For more information, check out the article “Step-by-Step Guide to Managing
P
http://tinyurl.com/e4e9k, but it could change by the time you read this.
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FIGURE 1.4 Edit specific layers of Windows Vista’s MLGPOs by first adding the Group
Policy Object Editor into a “naked” MMC. Then browse for the Windows Vista Local Group Policy
by firing up GPEDIT.MSC.
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" Use the Browse button to select a Group Palicy Object. Move Down
Group Policy Object:
Local Computer
Browse for a Group Policy Object Pl
4
4 Domains/OUs [ Stes | Computers | Users Al jicvancedsy
|- Lecal Users and Groups compatible with Local Group Polcy:
Uit in the Active
Name Group Policy Object Exists
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FIGURE 1.5 Below the words Console Root, you can see which layer of the local GPO
you're specifically editing.
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~ Windows Settings ﬁ’!,Uner Configuration
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Select an item to view its description. Name

In case you’re curious, Local Group Policy is stored in the C:\windows\system32\
grouppolicy directory. The structure found here mirrors what you’ll see later in Chapter 6
when we inspect the ins and outs of how Group Policy applies from Active Directory. Win-
dows Vista and Windows Server 2008 store Local User Policies (level 3) below C:\windows\
system32\grouppolicyusers.

You will notice one folder per user policy you have created, each named with the Security
ID (SID) of the relevant user object.

- @
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Active Directory-Based Group Policy

To use Group Policy in a meaningful way, you need an Active Directory environment. An
Active Directory environment needn’t be anything particularly fancy; indeed, it could consist
of a single Windows 2000, Windows 2003, or Windows Server 2008 Domain Controller and
perhaps just one Windows XP or Windows Vista workstation joined to the domain.

But Active Directory can also grow extensively from that original solitary server. You can
think of an Active Directory network as having four constituent and distinct levels that relate
to Group Policy:

= The local computer

= The site

*  The domain

*  The organizational unit (OU)

The rules of Active Directory state that every server and workstation must be a member of
one (and only one) domain and be located in one (and only one) site.

In Windows NT, additional domains were often created to partition administrative respon-
sibility or to rein in needless chatter between Domain Controllers. With Active Directory,
administrative responsibility can be delegated using OUs.

Additionally, the problem with needless domain bandwidth chatter has been brought under
control with the addition of Active Directory sites, which are concentrations of IP (Internet
Protocol) subnets with fast connectivity. There is no longer any need to correlate domains with
network bandwidth—that’s what sites are for!

Group Policy and Active Directory

When Group Policy is created at the local level, everyone who uses that machine is affected by
those wishes. But once you step up and use Active Directory, you can have nearly limitless
Group Policy Objects (GPOs)—with the ability to selectively decide which users and which
computers will get which wishes (try saying that five times quickly). The GPO is the vessel that
stores these wishes for delivery.

)/ Actually, you can have only 999 GPOs applied to a user or a computer.
‘&
When we create a GPO that can be used in Active Directory, two things happen: we create
some brand-new entries within Active Directory, and we automatically create some brand-

new files within our Domain Controllers. Collectively, these items make one GPO.
You can think of Active Directory as having three major levels:

= Site
=  Domain
= OU
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Additionally, since OUs can be nested within each other, Active Directory has a nearly
limitless capacity for where we can tuck stuff away.

In fact, it’s best to think of this design as a three-tier hierarchy: site, domain, and each
nested OU. When wishes, er, policy settings, are set at a higher level in Active Directory, they
automatically flow down throughout the remaining levels.

So, to be precise:

» Ifa GPO is set at the site level, the policy settings contained within affect those accounts
within the geography of the site. Sure, their user account could be in one domain and their
computer account could be in another domain. And of course, it’s likely that those accounts
are in an OU. But the account is affected only by the policy settings here because the account
is in a specific site. And logically, when a computer starts up in a new site, the User object
will also get its site-based Group Policy from the same place. This is based on the IP subnet
the user is a part of and is configured using Active Directory Sites and Services.

= Ifa GPO is set at the domain level, it affects those users and computers within the domain
and all OUs and all other OUs beneath it.

= Ifa GPO is set at the OU level, it affects those users or computers within the OU and all
other OUs beneath it (usually just called child or sub OUs).

By default, when a policy is set at one level, the levels below inberit the settings from the
levels above it. You can have “cumulative” wishes that keep piling on.

You might wonder what happens if two policy settings conflict. Perhaps one policy is set
at the domain level and another policy is set at the OU level, which reverses the edict in the
domain. The result is simple: Policy settings further down the food chain take precedence. For
instance, if a policy setting conflicts at the domain and OU levels, the OU level “wins.” Like-
wise, domain-level settings override any policy settings that conflict with previously set site-
specific policy settings. This might seem counterintuitive at first, so bear with me for a minute.

Take a look at the following illustration to get a view of the order of precedence.

Local (least amount
of precedence)

GPO linked to Site

GPO linked to Domain

|C Computer

User account Account

GPO linked to OU
(most amount of precedence)

+/@
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é/ The golden rule with Group Policy is truly “Last writer wins.”
P

However, don’t forget about any Local Group Policy that might have been set on a specific
workstation. Recall that for pre-Vista machines, everyone logging onto that workstation is
affected by that policy setting. You just learned how Vista’s MLGPOs add up to three layers
(where Windows XP’s local GPOs has just one).

Regardless, once that local policy is determined, only #hen do policy settings within Active
Directory (the site, domain, and OU) apply. So, sometimes people refer to the four levels of
Group Policy: local workstation, site, domain, and OU. Nonetheless, GPOs set within Active
Directory always trump the Local Group Policy should there be any conflict.

If this behavior is undesirable for lower levels, all the settings from higher levels can be
blocked with the Block Inheritance attribute on a given OU. Additionally, if a higher-level
administrator wants to guarantee that a setting is inherited down the food chain, they can apply
the Enforced attribute via the GPMC interface (or No Override attribute in the old-school par-
lance). (Chapter 2 explores both Block Inheritance and Enforced attributes in detail.)

application theory. I'll go through specific hands-on examples to illustrate

)’ Don’t sweat it if your head is spinning a little bit now from the Group Policy
Ad’TE
each of these behaviors so that you understand exactly how this works.

Linking Group Policy Objects

Another technical concept that needs a bit of description here is the “linking” of GPOs. When
a GPO is created at the site, domain, or OU level via the GUI (which we’ll do in a moment),
the system automatically associates that GPO with the level in which it was created. That asso-
ciation is called linking.

Linking is an important concept for several reasons. First, it’s generally a good idea to
understand what’s going on under the hood. However, more practically, the Group Policy
Management Console, or GPMC, as we’ll explore in just a bit, displays GPOs from their
linked perspective.

You can think of all the GPOs you create in Active Directory as children within a big swimming
pool. Each child has a tether attached around their waist, and an adult guardian is holding the
other end of the rope. Indeed, there could be multiple tethers around a child’s waist, with multiple
adults tethered to one child. A sad state indeed would be a child who has no tether but is just swim-
ming around in the pool unsecured. The swimming pool in this analogy is a specific Active Direc-
tory container named Policies (which we’ll examine closely in Chapter 6). All GPOs are born and
“live” in that specific domain. Indeed, they’re replicated to all Domain Controllers. The adult
guardian in this analogy represents a level in Active Directory—any site, domain, or OU.

%
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In our swimming pool example, multiple adults can be tethered to a specific child. With
Active Directory, multiple levels can be linked to a specific GPO. Thus, any level in Active
Directory can leverage multiple GPOs, which are standing by in the domain ready to be used.

Remember, though, unless a GPO is specifically linked to a site, a domain, or an OU, it does
not take effect. It’s just floating around in the swimming pool of the domain waiting for some-
one to make use of it.

I’ll keep reiterating and refining the concept of linking throughout these first four chapters.
And, in Chapters 2 and 4, I’ll discuss why you might want to “unlink” a policy.

This concept of linking to GPOs created in Active Directory can be a bit confusing. It will
become clearer a bit later as we explore the processes of creating new GPOs and linking to
existing ones. Stay tuned. It’s right around the corner.

An Example of Group Policy Application

At this point, it’s best not to jump directly into adding, deleting, or modifying our own GPOs.
Right now, it’s better to understand how Group Policy works “on paper.” This is especially
true if you’re new to the concept of Group Policy, but perhaps also if Group Policy has been
deployed by other administrators in your Active Directory.

By walking through a fictitious organization that has deployed GPOs at multiple levels, you’ll
be able to better understand how and why policy settings are applied by the deployment of GPOs.

Let’s start by taking a look at Figure 1.6, the organization for our fictitious example com-
pany, Example.com.

This picture could easily tell 1,000 words. For the sake of brevity, I’ve kept it down to
around 200. There are two domains, Example.com and Widgets.example.com. Let’s talk
about Example.com first:

*  The domain Example.com has two Domain Controllers. One DC, named EXAMPLEDCI1,
is physically located in the California site. Example.com’s other Domain Controller,
EXAMPLEDC?2, is physically located in the Phoenix site.

= As for PCs, they need to physically reside somewhere. Sally’s PC is in the California site;
Brett’s PC and Adam’s PC are in the Delaware site. JoesPC is in the Phoenix site.

= User accounts may or may not be in OUs. Dave’s and Jane’s account is in the Human
Resources OU.

= Computer accounts may or may not be in OUs. FredsPC is in the Human Resources OU.
Adam’s PC is specifically placed within the High Security OU. JoesPC, SallysPC and
BrettsPC aren’t in any OUs.

Using Active Directory Sites and Services, a schedule can be put in place to regulate com-
munication between EXAMPLEDCI1 located in California and EXAMPLEDC?2 located in
Phoenix. That way the administrator controls the chatter between the two Example.com
Domain Controllers and it is not at the whim of the operating system.

Another domain, called Widgets.example.com, has an automatic transitive two-way trust
to Example.com. There is only one Domain Controller in the Widgets.example.com domain,
named WIDDC1, and it physically resides at the Phoenix site. Last, there is MarksPC, a member
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of the Widgets.example.com domain, and it physically resides in the New York site and isn’t in
any OU.

FIGURE 1.6 Thisfictitious Example.com is relatively simple. Your environment may be
more complex.

California Site

%

SallysPC

Human Resources OU

FredsPC Dave

High
Security OU [ )

519(]

BrettsPC | Jane [ AdamsPC

—

Phoenix Site

JoesPC EXAM | Delaware Site
Example.com
WIDDC1
New York Site Two way trust
.
MarksPC Widgets.example.com

Understanding where your users and machines are is half the battle. The other half is understand-
ing which policy settings are expected to appear when they start logging onto Active Directory.

Examining the Resultant Set of Policy

As stated earlier, the effect of Group Policy is cumulative as GPOs are successively applied—start-
ing at the local computer, then the site, the domain, and each nested OU. The end result of what
affects a specific user or computer—after all Group Policy at all levels has been applied—is called
the Resultant Set of Policy, or RSoP. This is sometimes referred to as the RSoP calculation.

4~ 40
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Throughout your lifetime working with Group Policy, you will be asked to troubleshoot
the RSoP of client machines.

P shootthe RSoP of a particular configuration. Getting a good, early understanding
of how to perform manual RSoP calculations on paper is important because it's
a useful troubleshooting skill. In Chapter 4 and Chapter 6, we'll also explore addi-
tional RSoP skills—with tools and additional manual troubleshooting.

é/ Much of our dealings with Group Policy will be trying to understand and trouble-

Before we jump in to try to discover what the RSoP might be for any specific machine, it’s
often helpful to break out each of the strata—local computer, site, domain, and OU—and
examine, at each level, what happens to the entities contained in them. I’ll then bring it all
together to see how a specific computer or user reacts to the accumulation of GPOs. For these
examples, assume that no local policy is set on any of the computers; the goal is to get a better
feeling of how Group Policy flows, not necessarily what the specific end-state will be.

At the Site Level

Based on what we know from Figure 1.6, the GPOs in effect at the site level are shown below.

Site Computers Affected

California SallysPC, EXAMPLEDC1, and FredsPC
Phoenix EXAMPLEDC?2, JoesPC, and WIDDC1
New York MarksPC

Delaware AdamsPC and BrettsPC

If we look at the graphic again, it looks like Dave, for instance, resides in California and
Jane, for instance, resides in Delaware. But I don’t like to think about it like that. I prefer to
say that their accounts reside in OUs.

But, users are affected by site GPOs only when they log onto computers that are at a specific site.

In Figure 1.6, we have Dave and Jane’s account in the Human Resources OU. And that’s
great. But they’re only affected by California Site-Level GPOs if they travel to California. It
doesn’t matter where they usually reside; again, they’re only affected by the Site-Level GPOs
when they’re physically present in that site.

So, don’t think that user accounts reside at the site level. Rather, they reside in the OU level
but are using computers in the site and, hence, get the properties assigned to all users at that site.

P nets that constitute a site are assigned using this tool. That way, if a new com-
puter turns on in Delaware, Active Directory knows what site the computer is
in. For more information, check out http://tinyurl.com/b5mbn.

é/ Sites are defined using the Active Directory Sites and Services tool. IP sub-

- @
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At the Domain Level

Here’s what we have working at the domain level:

Domain Computers/Users Affected

Example.com Computers SallysPC, FredsPC, AdamsPC, BrettsPC, JoesPC,
EXAMPLEDC1, and EXAMPLEDC2

Example.com Users Dave and Jane

Widgets.example.com Computers WIDDC1 and MarksPC

At the OU Level

At the organizational unit level, we have the following:

Organizational Unit Computers/Users Affected

Human Resources OU Computers FredsPC is in the Human Resources OU; therefore,
it is affected when the Human Resources OU gets
GPOs applied. Additionally, the High Security
OU is contained inside the Human Resources OU.
Therefore, AdamsPC, which is in the High Security
OU, is also affected whenever the Human
Resources OU is affected.

Human Resources OU Users The accounts of Dave and Jane are affected when the
Human Resources OU has GPOs applied.

Bringing It All Together

Now that you’ve broken out all the levels and seen what is being applied to them, you can start to
calculate what the devil is happening on any specific user and computer combination. Looking at
Figure 1.6 and analyzing what’s happening at each level makes adding things together between the
local, site, domain, and organizational unit GPOs a lot easier.

Here are some examples of RSoP for specific users and computers in our fictitious environment:

FredsPC FredsPC inherits the settings of the GPOs from the California site,
then the Example.com domain, and last, the Human Resources OU.

MarksPC MarksPC first accepts the GPOs from the New York site and then the
Widgets.example.com domain. MarksPC is not in any OU; therefore,
no organizational unit GPOs apply to his computer.
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AdamsPC AdamsPC is subject to the GPOs at the Delaware site, the
Example.com domain, the Human Resources OU, and the High
Security OU.

Dave using AdamsPC is subject to the computer policies in the GPOs for the
AdamsPC Delaware site, the Example.com domain, the Human Resources OU,
and finally the High Security OU.
When Dave travels from California to Delaware to use Adam’s
workstation, his user GPOs are dictated from the Delaware site, the
Example.com domain, and the Human Resources OU.

At no time are any domain GPOs from the Example.com parent domain auto-
TE matically inherited by the Widget.example.com child domain. Inheritance for
GPOs only flows downward to OUs within a single domain—not between any

two domains—parent to child or otherwise, unless you explicitly link one of
those parent GPOs to a child domain container.

If you want one GPO to affect the users in more than one domain, you have four choices:
=  Precisely re-create the GPOs in each domain with their own GPO.
= Copy the GPO from one domain to another domain (using the GPMC, as explained in the
appendix).
= Use a third-party tool that can perform some magic and automatically perform the copy-

ing between domains for you.

= Do a generally recognized no-no called cross-domain policy linking. (Pl describe this no-no
in detail in Chapter 6 in the section “Group Policy Objects from a Domain Perspective.”)

Also, don’t assume that linking a GPO at a site level necessarily guarantees the results
to just one domain. In this example, as in real life, there is not necessarily a 1:1 correlation
between sites and domains.

At this point, we’ll put our example Example.com behind us. That was really an on-paper
exercise to allow you to get a feel for what’s possible in Group Policy land. From this point for-
ward, you’ll be doing most items in your test lab and following along.

Group Policy, Active Directory,
and the GPMC

Active Directory administrators already somewhat familiar with Group Policy will tell you that
finding what you need and understanding what’s going on under the hood can sometimes be con-
fusing. The interface used to create, modify, and manipulate Group Policy in the original iteration
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of Active Directory on Windows 2000 has led to numerous missteps and head scratching when
people try to figure out why something isn’t going the way it should.

Occasionally, the folks at Microsoft have recognized that the first iteration of a product
release has missed the mark a little in the way the product works, acts, or interfaces. They
often request additional customer feedback, embrace it, regroup, and return a new and
improved version of the product.

To make optimal use of Group Policy in an Active Directory environment, the Group Policy
team at Microsoft introduced a free, downloadable tool for managing Group Policy in Active
Directory in a meaningful way. It’s called the Group Policy Management Console, or GPMC,
as mentioned earlier. The GPMC isn’t part of the Windows 2000, Windows 2003, or Win-
dows XP operating systems; you need to fetch it and install it. It is, however, part of the ship-
ping version of Windows Vista and Windows Server 2008, so no extra effort is required.

Except it should be noted that the GPMC is uninstalled with Windows Vista when SP1 is
installed. And to reinstall it, you have to fetch what’s known as the Remote Server Adminis-
tration Tools, or RSAT. Inside RSAT is the updated GPMC.

I know, I know. This is all weird, right? I promise a detailed explanation of why in Chapter 3.

Kickin’ It Old School

Out of the box, the tools built into Windows 2000 and Windows 2003 domains use the old-
style interface. This interface is built into Active Directory Users and Computer and Active
Directory Sites and Services.

If you’ve never seen the old-style interface, you can do so right now before we leave it in the
dust for the new GPMC in the next section.

To see the old-style interface and create your first GPO at the domain level, follow these steps:

1. Log onto the Domain Controller DCO1 as the Administrator account (which is a Domain
Administrator).

2. Choose Start » All Programs » Administrative Tools and select Active Directory Users
and Computers. Alternatively, select Start » Run and select dsa.msc to open up Active
Directory Users and Computers.

3. Right-click the domain name and choose Properties from the shortcut menu, as shown in
Figure 1.7, to open the Properties dialog box for the domain.

4. Click the Group Policy tab.

There is a Default Domain Policy GPO, but you won't modify it at this time. (I'll
P talk about it in Chapter 7.)

5. Click the New button to spawn the creation of your first GPO.
6. For this first example, type My First GPO, as shown in Figure 1.8.
7. Highlight the policy and click Edit to open the Group Policy Management Editor.
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FIGURE 1.7 Right-click the domain name and choose Properties.
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At this point, things should look familiar, just like the Local Group Policy Management
Editor, with the user and computer nodes. For example, if you drill down into the Adminis-
trative Templates folder in the User Configuration » Policies folder, you can make a wish at
the domain level and all your computers will obey.

For now, don’t actually make any changes; just close the Group Policy Management Editor
and read on.

FIGURE 1.8 You'vejustcreated your first GPO in Active Directory.
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GPMC Overview

The Group Policy Management Console (GPMC) was created to help administrators work in
a “one-stop-shop” place for all Group Policy management functions. Since 2003, it was freely
downloadable as an add-on to either Windows XP or Windows Server 2003 systems. In Win-
dows Vista, it’s included in the box! That is, until you load Windows Vista’s SP1, when the
GPMC is uninstalled until you fetch the RSAT tools.

The best part is, it doesn’t matter if your Active Directory or domains or Domain Con-
trollers are Windows 2000, Windows 2003, or Windows 2008; it just matters that you have
Active Directory.

Why Abandon Old School?

In Figure 1.8, we were able to create our first GPO (even though we didn’t actually place any
policy settings in there). The interface seems reasonable enough to take care of such simple
tasks. And, heck, this interface is already part of the operating system, so why move away
from it?

The old-school way of viewing and managing Group Policy just isn’t scalable over the long
haul. This interface doesn’t show us any relationship between the GPO we just created and the
domain it’s in. As you’ll see in this chapter, the new interface demonstrates a much clearer rela-
tionship between the GPOs you create, the links it takes to use them, and the domains where
the GPOs actually “live.”

The old-style interface also provides no easy way to figure out what’s going on inside
the GPOs you create. To determine what changes are made inside a GPO, you need to
reopen each GPO and poke around. I’ve seen countless administrators open each and
every GPO in their domain and manually document their settings on paper for backup and
recovery purposes.

Indeed, backup and recovery is a really, really big deal, and the old-school mechanism
(via NTBACKUP) provided no realistic way to back up and recover GPOs without copious
amounts of surgery. The GPMC makes it a snap.

With that in mind, I encourage all of you—those currently using the original Windows
2000 old-school way and those who haven’t even yet been to school—to step up and try the
new way of doing things, the GPMC.

) Even though you cannot load the GPMC on a Windows 2000 Domain Con-
TE troller or a Windows 2000 Professional machine, it’s still capable of control-
ling Windows 2000 domains.

About the GPMC

The GPMC’s name says it all. It’s the Group Policy Management Console. Indeed, this will
be the MMC snap-in that you use to manage the underlying Group Policy mechanism. The
GPMC just helps us tap into those features already built into Active Directory. I’ll highlight
the mechanism of how Group Policy works throughout the next four chapters.
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One major design goal of the GPMC is to get a Group Policy—centric view of the lay of the
land. Compared with the old interface, the GPMC does a much better job of aligning the user
interface of Group Policy with what’s going on under the hood.

The GPMC also provides a programmatic way to manage your GPOs. In fact, the GPMC
scripting interface allows just about any GPO operation (other than to dive in and create or
modify actual policy settings). We’ll explore scripting with the GPMC in Chapter 11. So, if
you’re interested in scripting, you’ll need to have the GPMC bits loaded on the Windows XP,
Windows Vista, or Windows Server 2008 systems you want to script.

4 The GPMC scripts, which were previously part of the downloadable GPMC

ITE package, are notincluded in Windows Vista or Windows Server 2008. You have
to specifically download them from the GPMC scripting center at http://
tinyurl.com/23xfz3 or search for “Group Policy Management Console Sam-
ple Scripts” in your favorite search engine.

There are lots of ways you could manage your Group Policy universe. Some people walk up to
their Domain Controllers, log onto the console, and manage their Group Policy infrastructure
there. Others use a management workstation and manage their Group Policy infrastructure from
their own Windows XP or Windows Vista workstations.

I’ll talk more about the use and best practices of a Windows Vista management workstation
in Chapter 7.

Implementing the GPMC on Your
Management Station

AsImentioned, the GPMC isn’t part of the standard Windows 2003 or Windows XP package
out of the box. And, it’s already installed into Windows Vista and Windows Server 2008

That’s right—at first there’s nothing to download, nothing to install, and nothing to worry
about. That is, until Windows Vista + SP1 is installed, at which time the GPMC is uninstalled.

Don’t panic. It’s a quick hop, skip, and jump to get the latest GPMC from Microsoft’s web-
site. 'll show you how to do this in a minute.

Remember earlier I stated that you could manage your Active Directory from anywhere.

And this is true. You could walk up to a Domain Controller, you could install the GPMC on a
Windows XP or Windows Server 2003 server, or you could use Terminal Services to remotely con-
nect to a Domain Controller.

But in this book, you won’t be. Your ideal management station is a Windows Vista +
SP 1 + RSAT machine, or a Windows Server 2008 machine (which is ready to go, no down-
loads needed).

If you must use something else (Windows XP, Windows Server 2003, or Windows Vista
RTM), I provide some advice for those. But you’ll really want to use the recommended set to
get the most out of this book.
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Upgrading from NT 4 to Active Directory: Cleaning Up Old GPOs

If you have any remaining Windows 2000 Domain Controllers, you should have at least SP2
and preferably SP4 applied to them. This is because most Windows 2003 tools, including the
GPMC, use LDAP (Lightweight Directory Access Protocol) signing for all communication. For
more information, see the Microsoft Knowledge Base article 325465 at http://support
.microsoft.com/kb/325465.

After you run the GPMC, you may be prompted to “clean up” older GPOs the first time you
touch one. You should do so. Under the hood, the GPMC is adjusting some key security
descriptors in Active Directory.

The precise error message you'll getis, “The permissions for this GPO inthe SYSVOL folder are
inconsistent with those in Active Directory.” It is recommended that these permissions be con-
sistent. To change the SYSVOL permissions to those in Active Directory, click OK.”

By allowing this, you can do some fancy footwork later, as you'll see in the section “Advanced
Security and Delegation with the GPMC” in Chapter 2. You will see this message if your Win-
dows 2000 PDC-Emulator domain was upgraded from anything prior to SP4.

Using a Windows Vista or Windows Server 2008
Management Station

In this book, and in real life, I’'m going to recommend that you use what’s known as a Win-
dows Vista management station. And, ideally, that Windows Vista management station would
have SP1 with the updated (downloadable) GPMC installed on it.

You could also use a Windows Server 2008 machine as your management station, but it’s
not likely you’re going to install that puppy on your laptop or desktop.

So, just to be clear, the following two ways to create and manage GPOs are equal:

*=  Windows Vista + SP1 + newly downloadable GPMC (contained within the RSAT tools)
=  Windows Server 2008 with built-in GPMC

Pll usually just refer to a Windows Vista management station, and when I say that, I mean
what I have in that first bullet point. Just remember that you can use a Windows Server 2008
machine as your management station too.

I delve into this in serious detail in Chapter 7, but here’s the CliffsNotes, er, Jeremy’s
Notes version:

= Always use Windows Vista (or Windows Server 2008) as your management station and
you’ll always be able to control all operating systems’ settings: Windows Vista, Windows
Server 2008, and all earlier editions.

* If you have even one Windows Vista client machine (say in Sales, Marketing, etc.),
you’re going to need to manage it using a Windows Vista or Windows Server 2008 man-
agement station.
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*  Ifyou create a GPO using Windows Vista or Windows Server 2008 but then edit it using
an older operating system, you might not be able to “see” all the settings. And what’s
worse, some might actually be set (but you wouldn’t see them!).

What if you're not “allowed” to load Windows Vista on your management

P station? Well, you've got another option. Perhaps you can create a Windows
Vista or Windows Server 2008 machine to act as your management station,
say in the server room. Then set up Terminal Services or Remote Desktop to
utilize the GPMC remotely.

Again, in our examples we’ll call our machine VISTAMANAGEMENT, but you can use
either a Windows Server 2008 or Windows Vista + SP1 + RSAT for your best management
station experience.

Using a Windows Server 2008 Machine as Your Management Station
The latest GPMC is available in Windows Server 2008, except by default, it’s not immediately
usable. You need to install it or you won’t be able to use it. There are two ways to install the
GPMC: using Server Manager and also by the command line.

To install the GPMC using Server Manager:

Click Start, then point to Administrative Tools and select Server Manager.
In the Server Manager’s console tree, click Features and then select Add Features.

In the Add Feature Wizard dialog box, select Group Policy Management Console from
the list of features.

4. Click Install.

Close Server Manager once you’re done.
You can also install the GPMC using the command line:

1.  Open a command prompt as an Administrator.
2. In the command prompt, type ServerManagerCmd -install gpmc.

3. Close the command prompt when the installation has been completed.

Using a Windows Vista + SP1 + RSAT Machine as Your Management Station

The first step on your Windows Vista management-station-to-be is to install Windows Vista
SP1. Next, you’ll need to install RSAT. RSAT installs like a hotfix, and you may or may not
need to reboot after installation.

Then, on Windows Vista, go to Control Panel and select Programs. Select “Turn Win-
dows features on or off.” Locate the Feature Administration Tools and Role Administra-
tion Tools nodes. Select Group Policy Management Tools and Active Directory Domain
Services Tools, as seen in Figure 1.9.

Once you’re done, close the Windows Features window and, if prompted, reboot your
Windows Vista machine. The next time you boot, you’ll have Active Directory Users and
Computers, the GPMC, and other tools available for use in the rest of the book.
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FIGURE 1.9 The RSAT tools install like a hotfix but then must be individually selected
using Control Panel » Programs » Turn Windows features on or off.
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Other Management Station Options

If you positively cannot use a Windows Vista + SP1 + RSAT machine to be your management
station, and you must limp along with Windows Vista RTM, Windows XP, or Windows
Server 2003 machine, you can.

But know that you won’t get the full experience, and your screen might look different than
my screenshots.

If you must use a Windows Vista RTM machine On your Windows Vista machine, click
Start, and in the Start Search prompt, type the gpmc.msc command. With Windows Vista
RTM, the GPMC will just fire right up. I strongly encourage you to get to a Windows
Vista + SP1 + RSAT machine as soon as possible. However, you can also perform the steps
in the sidebar entitled “Adminpak on a Windows Vista RTM Management Station” to make
the most of your situation.

If you must use Windows XP or Windows Server 2003 management station Now, what if
you really, really cannot use a Windows Vista or Windows Server 2008 management station?
Well, then, sounds like you’re stuck with Windows XP or Windows Server 2003. With that
in mind, you can check out the sidebar titled “If You Must Use a Windows XP or Windows
Server 2003 Management Station.”
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If You Must Use a Windows XP or Windows Server 2003
Management Station

Again, | recommend against using the GPMC on Windows XP or Windows 2003 if you've even
got just one Windows Vista machine to use. Read Chapter 7 for the full rundown about why.

However, if you feel you must continue to use Windows XP or Windows Server 2003 as your
management station, you can download the older GPMC for free from www.microsoft.com/
grouppolicy. To be honest, | don't know how much longer they’ll maintain the original GPMC.
I wouldn't be surprised if, sometime soon, the only GPMC available is the updated edition (con-
tained within RSAT), which runs on Windows Vista (and is built into Windows Server 2008).

Click the link for the Group Policy Management Console to locate the download. Once it's
downloaded, the GPMC is called GPMC.MSI. You can install this on either Windows 2003 or
Windows XP with at least SP1, but nothing else. That is, you cannot load the GPMC on Win-
dows 2000 servers or workstations; but, as | noted before, the GPMC can manage Windows
2000 domains with Windows 2000 and Windows XP clients as well as Windows 2003 domains
with Windows 2000 or Windows XP clients.

Installing the GPMC does require certain prerequisites, which must be loaded in the order
listed here.

Loading the GPMC on Windows XP

If you intend to load the GPMC on a Windows XP machine to manage Group Policy in your
domain, follow these steps:

1. Atleast Windows XP Service Pack 1 is required. If you are unsure whether SP1 (or later) is
installed, run the WINVER command, which will tell you whether a service pack is installed.
So, if your Windows XP system doesn’t have at least SP1 installed, you should install the
latest service pack.

2. The GPMCrequiresthe .NET Framework 1.1 to run properly. Note that if you only have the
newer .NET Framework (2 or higher), it won't work. It simply must be .NET Framework 1.1.
If it's not installed, you'll need to download and install it. At last check, the .NET Frame-
work download was at a URL I've shortened to http://tinyurl.com/7vshz. If it's not
there, Google “NET Framework 1.1”

After downloading .NET Framework 1.1, double-click the install to get it going on your tar-
get Windows XP/SP1 (or greater) machine. Itisn’t a very exciting or noteworthy installation.

3. To install the GPMC, double-click the GPMC.MSI file you downloaded. If you're running
Windows XP with SP1, the GPMC installation routine will report that a hotfix (also known
as a QFE) is required and then proceed to automatically install the hotfix on-the-fly. This
hotfix (Q326469) is incorporated into Windows XP's SP2. So, if installing on a Windows
XP/SP2 machine, you won’t be bothered to install it.
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Technically the GPMC runs fine on .NET 2.0 only, but the MSI installer chokes when checking

.NET versions. If you have the skills to get around that, you're theoretically good to go with
just .NET 2.0.

Loading the GPMC on a Windows 2003 Domain Controller

If you intend to load the GPMC on a Windows 2003 Domain Controller or a member server,
there are just a couple of things to do:

1. Although there aren’t any Windows 2003 prerequisites, it's a good idea to install the
.NET Framework 1.1. If the GPMC installation doesn’t complain, you're good to go.
Otherwise, load it up.

2. To install the GPMC, double-click the GPMC.MST file you downloaded.

The Results of Loading the GPMC on Windows XP

After the GPMC is loaded on the machine from which you will manage Group Policy (the man-
agement workstation), you'll see that the way you view things has changed. If you take a look
in Active Directory Users and Computers (or Active Directory Sites and Services) and try to
manage a GPO, you'll see a curious link on the existing Group Policy tab (as seen below).
21
General | Managed By Giroup Policy I
“'ou have installed the Group Policy Management snapein, zo this tab i no

longer used.

To open Group Policy Management, chck Open

oK || Canced | sopy |

Additionally, you’ll see a Group Policy Management icon in the Administrative Tools folder in
the Start Menu folder.

Creating a One-Stop Shop MMC

As you’ll see, the GPMC is a fairly comprehensive Group Policy management tool. But the
problem is that right now the GPMC and the Active Directory Users and Computers snap-ins
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are, well, separate tools that each do a specific job. They’re not integrated to allow you to
work on both Users and Group Policy at the same time.

Often, you’ll want to change a Group Policy on an OU and then move computers to that
OU. Unfortunately, you can’t do so from the GPMC; you must to return to Active Directory
Users and Computers to finish the task. This can get frustrating quickly. The GPMC does
allow you to right-click at the domain level to choose to launch the Active Directory Users and
Computers console when you want, but I prefer a one-stop-shop view of my Active Directory
management. [t’s a matter of taste.

As a result, my preference is to create a custom MMC that shows both the Active Direc-
tory Users and Computers and GPMC in a one-stop-shop view. You can see what I mean in
Figure 1.10.

FIGURE 1.10 Usethe MMC to create a unified console.
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You might be wondering at this point, “So, Jeremy, what are the steps I need in order to
create this unified MMC console you’ve so neatly described and shown in Figure 1.102”

P tools, which are the Windows Vista equivalents to the Windows XP Adminis-
tration Pack tools. By using these tools, you can have a management station
with both Active Directory Users and Computers and the GPMC (both included
in the RSAT tools).

é/ By the time you read this, Microsoft will have hopefully released the RSAT
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Just click Start and type MMC at the Search prompt. Then add in both the Active Directory
Users and Computers and Group Policy Management snap-ins, as shown in Figure 1.11.

edit one Group Policy Object at a time), the Group Policy Object Editor (for
Local Group Policy), or the Group Policy Starter GPO Editor (which we use
later in Chapter 3).

é/ You won't need the Group Policy Management Editor (which allows you to
P

FIGURE 1.11 Add Active Directory Users and Computers and Group Policy
Management into your custom view.
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However, if the RSAT tools aren’t available by the time you read this, there’s another
option that will work. See the sidebar “Adminpak on a Windows Vista RTM Management
Station” for more information.

Adminpak on a Windows Vista RTM Management Station

Hopefully, by the time you read this, the equivalent of the Adminpak tools (to be known as
RSAT tools) will be available as a regular, good ol’ fashioned installation for Windows Vista.
But if not, you'll need a workaround to get the old tools to work on your updated machine.

If you want to run the Windows Server 2003 Adminpak on your Windows Vista RTM manage-
ment station, check out http://support.microsoft.com/default.aspx/kb/930056 for the
gory step-by-steps and gotchas.
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Get the latest version of the Windows Server 2003/SP1 Adminpak here: http://
tinyurl.com/9f2wm.

Ultimately, going through the pain will be worth it, because you’ll then have both the Active
Directory Users and Computer (from the Adminpak) and the GPMC (pre-loaded with Windows
Vista) in one place.

Then, you can just fire up MMC. exe and add in the two snap-ins you need, and it'll look just like
Figure 1.9 (except it'll be on your Windows Vista management station).

Again, this pain is only necessary if for some reason you cannot use a Windows Server 2008
or Windows Vista + SP1 + RSAT machine for your management station.

Once you have added both snap-ins into your console, you’ll really have a near-unified view
of most of what you need at your fingertips. Both Active Directory Users and Computers and
the GPMC can create and delete OUs. Both tools also allow administrators to delegate per-
missions to others to manage Group Policy, but that’s where the two tools’ functionality over-
lap ends.

The GPMC won’t show you the actual users and computer objects inside the OU, so delet-
ing an OU from within the GPMC is dicey at best because you can’t be sure of what’s inside!

You can choose to add other snaps-ins too, of course, including Active Directory Sites and
Services or anything else you think is useful. The illustrations in the rest of this book will show
both snap-ins loaded in this configuration.

You can launch the GPMC from either the new link in Active Directory Users and Com-
puters (or Active Directory Sites and Services) or directly from the new icon in the Start menu.
However, clicking Open in the existing tools has a slight advantage of telling the GPMC to
“snap to” the location in Active Directory on which you are currently focused.

Using the GPMC in Active Directory

For the examples in this book, I'll refer to our sample Domain Controller, DCO1,
TE which is part of my example Corp.com domain. For these examples, you can

choose to rename the Default-First-Site-Name site or not—your choice.

Let’s start with some basics to ensure that things are running smoothly. For most of the
examples in this book, you’ll be able to get by with just the one Domain Controller and one
or two workstations that participate in the domain, for verifying that your changes took place.

Again, I encourage you to try these examples in your test lab and not to directly try them
on your production network. This will help you avoid a CLM (Career-Limiting Move).

For our examples, we’ll assume you’re using VISTAMANAGEMENT as your management
station, which is a Windows Vista + SP1 + RSAT.
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Active Directory Users and Computers vs. GPMIC

The main job of Active Directory Users and Computers is to give you an Active Directory
object—centric view of your domain. Active Directory Users and Computers lets you deal with
users, computers, groups, contacts, some of the Flexible Single Master Operations roles
(FSMO roles), and delegation of control over user accounts as well as change the domain
mode and define advanced security and auditing inside Active Directory. You can also create
OUs and move users and computers around inside those OUs. Other administrators can then
drill down inside Active Directory Users and Computers into an OU and see the computers,
groups, contacts, and so on that you’ve moved to those OUs.

But the GPMC has one main job: to provide you with a Group Policy—centric view of all you
control. All the OUs that you see in Active Directory Users and Computers are visible in the
GPMC. Think about it—it’s the same Active Directory behind the scenes “storing” that OU.

However, the GPMC does not show you users, computers, contacts, and such. When you
drill down into an OU inside the GPMC, you’ll see but one thing: the GPOs that affect the
objects inside the OU.

In Figure 1.10, you were able to see the Active Directory Users and Computers view as
well as the GPMC view—rolled into one MMC that we created earlier. The Active Directory
Users and Computers view of Temporary Office Help and the GPMC view of the same OU
is radically different.

When focused at a site, a domain, or an OU within the GPMC, you see only the GPOs that
affect that level in Active Directory. You don’t see the same “stuff” that Active Directory Users
and Computers sees, such as users, computers, groups, or contacts.

The basic overlap in the two tools is the ability to create and delete OUs. If you add or delete
an OU in either tool, you need to refresh the other tool by pressing F5 to see the update. For
instance, in Figure 1.10, you could see that my Active Directory has several OUs, including one
named Temporary Office Help.

ING cannot see the Active Directory objects inside the OU (such as users and
computers), you don‘t really know how many objects you're about to delete.
So be careful!

@:" Deleting an OU from inside the GPMC is generally a bad idea. Because you

If T delete the Temporary Office Help OU in Active Directory Users and Computers, the
change is not reflected in the GPMC window until it’s refreshed. And vice versa.

Adjusting the View within the GPMC

The GPMC lets you view as much or as little of your Active Directory as you like. By default,
you view only your own forest and domain. You can optionally add in the ability to see the
sites in your forest as well as the ability to see other domains in your forest or domains in other
forests, although these views might not be the best for seeing what you have control over.
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Viewing sites in the GPMC When you create GPOs, you won’t often create GPOs that affect
sites. The designers of the GPMC seem to agree; it’s a bit of a chore to apply GPOs to sites.
To do so, you need to link an existing GPO to a site. You’ll see how to do this a bit later in
this chapter.

However, you first need to expose the site objects in Active Directory. To do so, right-click the
Sites object in GPMC, choose Show Sites from the shortcut menu (see Figure 1.12), and then
click the check box next to each site you want to expose.

In our first example, we’ll use the site level of Active Directory to deploy our first Group Policy
Object. At this point, go ahead and enable the Default-First-Site so that you can have it ready
for use in our own experiments.

Viewing other domains in the GPMC To see other domains in your forest, drill down to the
Forest folder in Group Policy Management, right-click Domains, choose Show Domains, and
select the other available domains in your forest. Each domain will now appear at the same
hierarchical level in the GPMC.

Viewing other forests in the GPMC To see other forests, right-click the root (Group Policy
Management), and choose Add Forest from the shortcut menu. You’ll need to type the name
of the Active Directory forest you want to add. If you want to add or subtract domains within
that new forest, follow the instructions in the preceding paragraph.

FIGURE 1.12 You need to expose the Active Directory sites before you can link GPOs
to them.
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You can add forests with which you do not have a trust. However, GPMC

P defaults will not display these domains as a safety mechanism. To turn off the
safety, choose View » Options to open the Options dialog box. In the General
tab, clear Enable Trust Detection and click OK.

Now that we’ve adjusted our view to see the domains and forests we want, let’s examine
how to manipulate our GPOs and GPO links.

The GPMC-centric View

As I stated earlier, one of the fundamental concepts of Group Policy is that the GPOs them-
selves live in the “swimming pool” that is the domain. Then, when a level in Active Directory
needs to use that GPO, there is simply a link to the GPO.

Figure 1.13 shows what our swimming pool will eventually look like when we’re done with
the examples in this chapter.

FIGURE 1.13 Imagine your about-to-be-leveraged GPOs as just hanging out in the
swimming pool of the domain.
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The Corp.com GPO Swimming Pool
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Our swimming pool will be full of GPOs, with various levels in Active Directory “linked”
to those GPOs. To that end, you can drill down, right now, to see the representation of the
swimming pool. It’s there, waiting for you. Click Group Policy Management » Forest »
Domains » Corp.com » Group Policy Objects to see all the GPOs that exist in the domain

(see Figure 1.14).

FIGURE 1.14 The Group Policy Objects folder highlighted here is the representation of

the swimming pool of the domain that contains your actual GPOs.
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All GPOs in the domain are represented in the Group Policy Objects folder. As you can
see, when the Temporary Office Help OU is shown within the GPMC, a relationship exists
between the OU and the “Hide Desktop Settings Option” GPO. That relationship is
the tether to the GPO in the swimming pool—the GPO link back to “Hide Desktop Set-
tings Option.” You can see this linked relationship because the “Hide Desktop Settings
Option” icon inside Temporary Office Help has a little arrow icon, signifying the link
back to the actual GPO in the domain. The same is true for the “Default Domain Policy,”
which is linked at the domain level, but the actual GPO is placed below the Group Policy

Objects folder.

If you're just getting started, it's not likely you’ll have more than the “Default
Domain Controllers Policy” GPO and “Default Domain Policy” GPO. That's
OK. You'll start getting more GPOs soon enough. Oh, and for now, please
don’t modify the default GPOs. They’'re a bit special and are covered in great
detail in Chapter 8.
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Our Own Group Policy Examples

Now that you’ve got a grip on honing your view within the GPMC, let’s take it for a quick spin
around the block with some examples!

For this series of examples, we’re going after the users who keep fiddling with their display
gadgets in Windows Vista, Windows XP, and Windows 2000.

If you want to see these examples in action using Windows XP, first start out on XPPRO1
by checking out the default Display Properties dialog box. Just right-click the Desktop and
choose Properties from the shortcut menu. You’ll see several tabs, including Screen Saver,
Appearance, and Settings, as shown in Figure 1.15 (left screen).

If you want to see these examples in action using Windows Vista, first start out on VISTA1
by looking at the “Personalize appearance and sounds” page, which is located by right-clicking
the Desktop and choosing Personalize. You’ll see several entries, including Screen Saver, Win-
dows Color and Appearance, and Display Settings, as shown in Figure 1.15 (right screen).

FIGURE 1.15 InWindows XP, all the tabs in the Display Properties dialog box are
available by default (left screen). In Windows Vista, we can see lots of available areas in the
Personalization screen, shown on the right.
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Since they’re called tabs in Windows XP and entries or options in Windows

TE Vista, I'll just generally call them options from here on out.
For our first use of Group Policy, we’re going to produce four “edicts” (for dramatic effect,
you should stand on your desk and loudly proclaim these edicts with a thick British accent):

= At the site level, there will be no more ability to change screensavers.

* At the domain level, there will be no Desktop Settings option in the Windows Vista Per-
sonalization page (or Desktop tab in the Display Properties dialog box for Windows XP).
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* At the Human Resources Users OU level, there will be no Display Settings option in the
Windows Vista Personalization page (or Settings tab in the Display Properties for Win-
dows XP). And, while we’re at it, let’s bring back the ability to change screensavers!

* At the Human Resources Computers OU, we’ll make it so whenever anyone uses a
Human Resources computer, calc.exe automatically launches after login.

Following along with these concrete examples will reinforce the concepts presented earlier.
Additionally, they are used throughout the remainder of this chapter and the book.

Understanding GPMC'’s Link Warning

As you work through the examples, you’ll do a lot of clicking around. When you click a GPO
link the first time, you'll get this message:

| Group Policy Management Conscle
“fou have selected a link to a Group Policy Object (GPO). Except for

changes to ink properties, changes you make here are global to the GPO,
and will impact all other locations whese this GPO is inked.

/| Do not show this message again oK |

This message is trying to convey an important sentiment; that is, multiple levels in Active
Directory may be linked back and use the exact same GPO. The idea is that multiple levels of
Active Directory could use the exact same Group Policy Object contained inside the Group
Policy Objects container—but just be linked back to it.

What if you modify the policy settings by right-clicking a policy link and choosing Edit from the

shortcut menu? All instances in Active Directory that link to that GPO embrace the new settings.
If this is a fear, you might want to create another GPO and then link it to the level in Active Direc-
tory you want. More properties are affected by this warning, and we'll explore them in Chapter 5.

If you've squelched this message by selecting “Do not show this message again,” you can get
it back. In the GPMC in the menus, choose View » Options and select the General tab, select
“Show confirmation dialog to distinguish between GPOs and GPO links", and click OK.

More about Linking and the Group Policy
Objects Container

The GPMC s a fairly flexible tool. Indeed, it permits the administrator to perform many tasks in
different ways. One thing you’ll do quite a lot in your travels with the GPMC is to actually create
your own Group Policy Objects. Again, GPOs live in a container within Active Directory and are
represented within the Group Policy Objects container (the swimming pool) inside the domain
(seen in Figure 1.13, earlier in this chapter). Any levels of Active Directory—site, domain, or OU—
simply link back to the GPOs hanging out in the Group Policy Objects container.
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To apply Group Policy to a level in Active Directory (site, domain, or OU) using the GPMC,
you have two options:

»  Create the GPOs in the Group Policy Objects container first. Then, while focused at the
level you want to command in Active Directory (site, domain, or OU), manually add a
link to the GPO that is in the Group Policy Objects container.

= While focused at the level you want to command in Active Directory (domain or OU), create
the GPOs in the Group Policy Objects container and automatically create the link. This link
is created at the level you’re currently focused at back to the GPO in the Group Policy
Objects container.

Which is the correct way to go? Both are perfectly acceptable because both are really doing
the same thing.

In both cases the GPO itself does not “live” at the level in Active Directory at which you’re
focused. Rather, the GPO itself “lives” in the Group Policy Objects container. The link back
to the GPO inside the Group Policy Objects container is what makes the relationship between
the GPO inside the Group Policy Objects container swimming pool and the level in Active
Directory you want to command.

To get the hang of this, let’s work through some examples. First, let’s create our first GPO
in the Group Policy Objects folder. Follow these steps:

1. Launch the GPMC. Again, click Start, and then in the search box, just type GPMC.MSC.

2. Traverse down by clicking Group Policy Management » Forest » Domains »
Corp.com » Group Policy Objects.

3. Right-click the Group Policy Objects folder and choose New from the shortcut menu as
shown in Figure 1.16 to open the New GPO dialog box.

4. Let’s name our first edict, er, GPO, something descriptive, such as “Hide Screen
Saver Option.”

5. Once the name is entered, you’ll see the new GPO listed in the swimming pool. Right-click the
GPO, and choose Edit as shown in Figure 1.17 to open the Group Policy Management Editor.

6. To hide the Screen Saver option, drill down by clicking User Configuration » Policies »
Administrative Templates » Control Panel > Display. Double-click the Hide Screen Saver tab
policy setting to open the Hide Screen Saver Tab Properties screen, as shown in Figure 1.18.
Select the Enabled setting, and click OK.

7. Close the Group Policy Management Editor.

) Note how the policy setting name is called Hide Screen Saver Tab. However,
TE in Windows Vista, there isn’t a “tab” as there is in either Windows 2000 or
Windows XP. It's more like an option on the Personalization page. You'll see
this later. Just note that not all policy settings have a 100 percent direct mean-
ing sometimes, in rare occurrences like this.
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FIGURE 1.16 You create your first GPO in the Group Policy Object container by right-
clicking and choosing New.
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FIGURE 1.17 You can right-click the GPO in the Group Policy Objects container and
choose Edit from the shortcut menu to open the Group Policy Management Editor.
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FIGURE 1.18 Double-click the policy setting and “Enable” it.
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Understanding Our Actions

Now that we have this “Hide Screen Saver Option” edict, er, GPO floating around in the Group
Policy Objects container—in the representation of the swimming pool of the domain—what have
we done? Not a whole lot, actually, other than create some bits inside Active Directory and upon
the Domain Controllers. By creating new GPOs in the Group Policy Objects folder, we haven’t
inherently forced our desires on any level in Active Directory—site, domain, or OU.

To actually make a level in Active Directory accept our will, we need to link this new Group
Policy Object to an existing level. Only then will our will be accepted and embraced. Let’s do
that now.

Applying a Group Policy Object to the Site Level

The least-often-used level of Group Policy application is at the site. This is because it’s got the
broadest stroke but the bluntest application. And more and more organizations use high-speed
links everywhere, so it’s not easy to separate computers into individual sites because (in some
organizations) Active Directory is set up to see the network as just one big site!

Additionally, since Active Directory states that only members of the Enterprise Adminis-
trators (EAs) can modify sites and site links, it’s equally true that only EAs (by default) can add
and manipulate GPOs at the site level.
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4 When a tree or a forest contains more than one domain, only the EAs and the
ITE Domain Administrators (DAs) of the root domain can create and modify sites

and site links. When multiple domains exist, DAs in domains other than the
root domain cannot create sites or site links (or site-level GPOs).

However, site GPOs might come in handy on an occasion or two. For instance, you might
want to set up site-level GPO definitions for network-specific settings, such as Internet
Explorer proxy settings or an IP security policy for sensitive locations. Setting up site-based
settings is useful if you have one building (set up explicitly as an Active Directory site) that
has a particular or unique network configuration. You might choose to modify the Internet
Explorer proxy settings if this building has a unique proxy server. Or in the case of IP secu-
rity, perhaps this facility has particularly sensitive information, such as confidential records
or payroll information.

Therefore, if you’re not an EA (or a DA of the root domain), it’s likely you’ll never get
to practice this exercise outside the test lab. And, note that in the upcoming chapters I’ll
show you how to delegate these rights to other administrators, like OU administrators
around the bend.

For now, we’ll work with a basic example to get the feel of the Group Policy Manage-
ment Editor.

ING logon times and WAN (Wide Area Network) traffic if not performed correctly.
For more information, see Chapter 6 in the section “Group Policy Objects
from a Site Perspective.”

ﬁl‘ Implementing GPOs linked to sites can have a substantial impact on your

We already stood on our desks and loudly declared that there will be no Screen Saver options
at our one default site. The good news is that we’ve already done two-thirds of what we need to
do to make that site accept our will: we exposed the sites we want to manage, and we created
the “Hide Screen Saver Option” GPO in the Group Policy Objects container.

Now all we need do is to tether the GPO we created to the site with a GPO link.

To remove the Screen Saver option using the Group Policy Management Editor at the site
level, follow these steps:

1. Inside the GPMC snap-in, drill down by clicking the Group Policy Management folder,
the Forest folder, and the Sites folder.

2. Find the site to which you want to deliver the policy. If you have only one site, it is likely
called Default-First-Site-Name.

3. Right-click the site, and choose Link an Existing GPO, as shown in Figure 1.19.

Now you can select the “Hide Screen Saver Option” GPO from a list of GPOs in the
Group Policy Objects container in the domain.
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Applying Group Policy Objects to the OU Level

OUs are wonderful tools for delegating away unpleasant administrative duties, such as pass-
word resets or modifying group memberships. But that’s only half their purpose. The other
half is to be able to apply Group Policy.

You’ll likely find yourself making most Group Policy additions and changes at the OU
level, because that’s where you have the most flexibility and the OU is the most refined instru-
ment to affect users. Once OU administrators become comfortable in their surroundings, they
want to harness the power of Group Policy.

Preparing to Delegate Control

To create a GPO at the OU level, you must first create the OU and a plan to delegate. For the

examples in this book, we’ll create three OUs that look like this:

=  Human Resources

=  Human Resources Users

=  Human Resources Computers

Having separate OUs for your users and computers is a good idea—for both delegation of
rights and also GPO design. Microsoft considers this a best practice. In the Human Resources

Users OU in our Corp.com domain, we’ll create and leverage an Active Directory security

group to do our dirty work. We’ll name this group HR-OU-Admins and put our first users

inside the HR-OU-Admins security group. We’ll then delegate the appropriate rights necessary
for them to use the power of GPOs.

To create the Human Resources Users OU using your VISTAMANAGEMENT machine,
follow these steps:

1. Earlier, you created a “unified console” where you housed both Active Directory Users
and Computer and the GPMC. Simply use Active Directory Users and Computers, right-
click the domain name, and choose New » Organizational Unit, which will allow you to
enter in a new OU name. Enter Human Resources as the name.

2. Inside the Human Resources OU, create two more OUs—Human Resources Computers
and Human Resources Users, as shown in Figure 1.23.

Alternatively, you can create the OU in the GPMC. Just right-click the domain
P and choose New Organizational Unit from the shortcut menu.

To create the HR-OU-Admins group, follow these steps:

1. In Active Directory Users and Computers, right-click the new Human Resources Users
OU and choose New » Group.

2. Create the new group HR-OU-Admins as a new Global Security group.

%

—®






%% é 75894c01.fm Page 55 Sunday, April 13,2008 2:13 PM

Our Own Group Policy Examples 55

= The two folders are the default location where older tools drop new accounts in when
creating new users and computers. These older tools are in the Windows NT 4 User Man-
ager (which still works in Active Directory domains). Additionally, command-line tools,
such asthe net user and net group, will add accounts to these two folders. Similarly, the
Computers folder is the default location for any new client workstation or server that
joins the domain. The same goes when you create computer accounts using the net
computer command.

If you execute one of these commands, the objects you create will wind up in either the Users
folder or the Computers folder. But really, you don’t want your users or computers to be in
these folders—you want them in OUs. That’s where the action is because you can apply
Group Policy to OUs, not to these folders! Yeah, sure, these users and computers are affected
by site- and domain-level GPOs. But really the action is at the OU level, and you want your
computer and user objects to be placed in OUs as fast as possible —not sitting around in these
generic Computers and Users folders.

To that end, domains which are at least at the “Windows 2003 functional level” have two tools to
redirect the default location of new users and computers to the OUs of your choice. For example,
suppose you want all new computers to go to a NewComputers OU and all new usersto goto a
NewUsers OU. And you want to link several GPOs to the NewUsers and NewComputers OUs to
ensure that new accounts immediately have some baseline level of security, restriction, or pro-
tection. Without a little magic, new user accounts created using older tools won't automatically
be placed there.

In Windows 2003 Active Directory, Microsoft has provided REDIRUSR and REDIRCMP commands
that take a distinguished name, like this:

REDIRCMP ou=newcomputers,dc=corp,dc=com and/or

REDIRUSR ou=newusers,dc=corp,dc=com

Now if you link GPOs to these OUs, your new accounts will get the Group Policy Objects dic-
tating settings to them at an OU level. This will come in handy when users and computers
aren’t specifically created in their final destination OUs.

To learn more about these tools, see the Microsoft Knowledge Base article 324949 at
http://support.microsoft.com/kb/324949.

To add Frank Rizzo to the HR-OU-Admins group, follow these steps:
1. Double-click the HR-OU-Admins group.
2. Click the Members tab.
3. Add Frank Rizzo.

When it’s all complete, your OU structure with your first user and group should look like
Figure 1.23, shown previously.

%

+/@






%I% é 75894c01.fm Page 57 Sunday, April 13,2008 2:13 PM

Our Own Group Policy Examples 57

example, only Manage Group Policy Links is required. Avoid selecting Gen-
erate Resultant Set of Policy (Planning) and Generate Resultant Set of Policy
(Logging) at this time. You'll see where they come in handy in Chapter 4.

é/ You might want to click some or all the other check boxes as well, but for this
P

) The Manage Group Policy Links task assigns the user or group Read and

TE Write access over the gPLink and gPOptions properties for that level. To see
or modify these permissions by hand, open Active Directory Users and Com-
puters and choose View » Advanced Features. If later you want to remove a
delegated permission, it’s a little challenging. To locate the permission that
you set, right-click the delegated object (such as OU), then click the Properties
tab, click the Security tab, choose Advanced, and dig around until you come
across the permission you want to remove. Finally, delete the corresponding
access control entry (ACE).

Adding a User to the Server Operators Group (Just for This Book)

Under normal conditions, nobody but Domain Administrators, Enterprise Administrators, or
Server Operators can walk up to Domain Controllers and log on. For testing purposes only,
though, we’re going to add our user, Frank, to the Server Operators group so he can easily
work on our DC0O1 Domain Controller.

To add a user to the Server Operators group, follow these steps:

1. In Active Directory Users and Computers, double-click Frank Rizzo’s account under the
Human Resources Users OU.

Click the Member Of tab and click Add.
Select the Server Operators group and click OK.
Click OK to close the Properties dialog box for Frank Rizzo.

Normally, you wouldn’t give your delegated OU administrators Server Operators access.
You’re doing it solely for the sake of this example to allow Frank to log on locally to your
Domain Controllers.

Testing Your Delegation of Group Policy Management

At this point, log off as Administrator and log in as Frank Rizzo (frizzo@corp.com).
Now follow these steps to test your delegation:

1. Choose Start and type in GPMC.MSC at the Start Search prompt to open the GPMC.

2. Drill down through Group Policy Management, Domains, Corp.com, and Group Policy
Objects. If you right-click Group Policy Objects in an attempt to create a new GPO, you’ll
see the shortcut menu shown in Figure 1.25.
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Because Frank is unable to create GPOs in the swimming pool of the domain (the Group
Policy Objects container), he is also unable by definition to “Create a GPO in this domain, and
Link it here.” Although Frank (and more specifically, the HR-OU-Admins) has been delegated
the ability to “Manage Group Policy links,” he cannot create new GPOs. Frank (and the other
potential HR-OU-Admins) has only the ability to link an existing GPO.

Understanding Group Policy Object Linking Delegation

When we were logged on as the Domain Administrator, we could create GPOs in the Group
Policy Objects container, and we could “Create a GPO in this domain, and Link it here” at the
domain or OU levels. But Frank cannot.

Here’s the idea about delegating the ability to link to GPOs: someone with a lot of brains
in the organization does all the work in creating a well-thought-out and well-tested GPO.
Maybe this GPO distributes software, maybe it sets up a secure workstation policy, or perhaps
it runs a startup script. You get the idea.

Then, others in the organization, like Frank, are delegated just the ability to link to that
GPO and use it at their level. This solves the problem of delegating perhaps too much control.
Certainly some administrators are ready to create their own users and groups, but other
administrators may not be quite ready to jump into the cold waters of Group Policy Object
creation. Thus, you can design the GPOs for other administrators; they can just link to the
ones you (or others) create.

When you (or someone with the right to link GPOs) selects “Link an Existing GPO,” as
seen in Figure 1.26, you can choose a GPO that’s already been created—and hanging out in
the domain swimming pool—the Group Policy Objects container.

In this example, the HR-OU-Admins members, such as Frank, can leverage any currently
created GPO to affect the users and computers in their OU—even if they didn’t create it them-
selves. In this example, Frank has linked to an existing GPO called “Word 2003 Settings.”
Turns out that some other administrator in the domain created this GPO, but Frank wants to
use it. So, because Frank has Manage Group Policy Links rights on the Human Resources OU
(and OUs underneath it), he is allowed to link to it.

But, as you can see in Figure 1.27, he cannot edit the GPOs. Under the hood, Active Directory
doesn’t permit Frank to edit GPOs he didn’t create (and therefore doesn’t own).

4 In Chapter 2, I'll show you how to grant specific rights to allow more than just
P the original creator (and now owner) of the object to edit specific GPOs.

Giving the ability to just link to existing GPOs is a good idea in theory, but often OU
administrators are simply given full authority to create their own GPOs (as you’ll see later).
For this example, don’t worry about linking to any GPOs. Simply cancel out of the Select GPO
screen, close the GPMC, and log off from the server as Frank Rizzo.
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3. By default, the Group Policy Creator Owners group is located in the Users folder in the
domain. Double-click the Group Policy Creator Owners group and add the HR-OU-
Admins group and/or Frank Rizzo.

P from NT 4, you will not be able to add the HR-OU-Admins group until the
domain mode has been switched to Windows 2000 Native or Windows 2003
Functional level. Switch the domain by using Active Directory Domains and
Trusts (or Active Directory Users and Computers). Switching the domain
mode is a one-way operation, which shuts out older Domain Controllers. If
you are not prepared to make the switch to Native mode, you'll only be able
to add individual members—such as Frank Rizzo—and not a group.

é/ If you just created a new Windows 2003 domain or upgraded your domain

% In Chapter 2, you'll see an alternate way to allow users to create GPOs.
P

Creating and Linking Group Policy Objects
at the OU Level

At the site level, we hid the Screen Saver option. At the domain level, we chose to get rid of the
Desktop Settings option in the Windows Vista Personalization page (or Desktop tab in the Dis-
play Properties dialog box for Windows XP). At the OU level, we have two jobs to do:

*  Hide the Display Settings option for Windows Vista (or Settings tab in Windows XP).
=  Restore the Screen Saver option that was taken away at the site level.
To create a GPO at the OU level, follow these steps:

1. Since you’re on VISTAMANAGEMENT, log off as Administrator and log back on as
Frank Rizzo (frizzo@corp.com)

Choose Start and type GPMC.MSC in the Start Search prompt.

Drill down until you reach the Human Resources Users OU, right-click it, and choose
“Create a GPO in this domain, and Link it here” from the shortcut menu to open the New
GPO dialog box.

4. In the New GPO dialog box, type in the name of your new GPO, say “Hide Display Set-
tings Option/Restore Screen Saver Option.” This will create a GPO in the Group Policy
Objects container and link it to the Human Resources Users OU.

5. Right-click the Group Policy link and choose Edit from the shortcut menu to open the
Group Policy Management Editor.




%% é 75894¢c01.fm Page 62 Sunday, April 13,2008 2:13 PM

62 Chapter 1 = Group Policy Essentials

6. To hide the Display Settings option in the Windows Vista Personalization page (or Set-
tings tab in the Display Properties for Windows XP), drill down through User Configu-
ration » Policies » Administrative Templates » Control Panel > Display and double-
click the Hide Settings Tab policy setting. Change the setting from Not Configured to
Enabled, and click OK.

7. Torestore the Screen Saver setting for Windows Vista (or Screen Saver tab in Windows XP),
double-click the Hide Screen Saver Tab policy setting. Change the setting from Not Con-
figured to Disabled, and click OK.

8. Close the Group Policy Management Editor to return to the GPMC.

< By disabling the Hide Screen Saver Tab policy setting, you're reversing the
P Enable setting set at a higher level. See the sidebar “The Three Possible
Settings: Not Configured, Enabled, and Disabled” later in this chapter.

Verifying Your Changes at the OU Level

On your test Windows XP or Windows Vista machine in the domain (XPPRO1 or VISTA1),
log back on as Frank.

On XP, right-click the Desktop and choose Display from the shortcut menu to open the
Display Properties dialog box. Note that the Display Settings Option (on Windows Vista) or
Settings tab (on Windows XP) is missing but that the Screen Saver option is back, as shown
on the left in Figure 1.28.

On Windows Vista, right-click the Desktop and choose Personalize. Note that the Win-
dows Vista behavior is somewhat different this time: the Display Settings field is still available,
but clicking on it yields an access error due to Group Policy enforcement. And, because of our
edict, note that the Screen Saver entry has returned and is clickable (as seen in the right screen
of Figure 1.28).

This test proves, once again, that even OU administrators are not automatically immune
from policy settings. Chapter 4 explains how to change this behavior.

Group Policy Strategy: Should | Create More or Fewer GPOs?

At times, you'll want to lock down additional functions for a collection of users or computers.
For example, you might want to specify that no users in the Human Resources Users OU can
use Control Panel.

Atthe Human Resources Users OU level, you've already set up a GPO that contained a policy setting
to hide the Display Settings option in the Windows Vista Personalization page (or Settings tab for
Windows XP). You now have a decision to make. You can create a new GPO that affects the Human
Resources Users OU, give it a descriptive name, say “No One Can Use Control Panel,” and then
drill down through User Configuration > Policies » Administrative Templates » Windows Compo-
nents > Control Panel and enable the policy setting named Prohibit Access to Control Panel.

%
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Oryou could simply modify your existing GPO, named “Hide Display Settings Option/Restore
Screen Saver Option,” so that it contains additional policy settings. You can then rename your
GPO to something that makes sense and encompasses the qualities of all the policy changes,
say “Our Human Resources Users’ Desktop Settings.”

Here's the quandary: The former method (one policy setting per GPO) is certainly more
descriptive and definitely easier to debug should things go awry. If you have only one policy
set inside the GPO, you have a better handle on what each one is affecting. If something goes
wrong, you can dive right into the GPO, track down the policy setting, and make the necessary
changes, or you can disable the ornery GPO (as discussed later).

The second method (multiple policy settings per GPO) is a teeny-weeny bit faster for your
computers and users at boot or logon time because each additional GPO takes some minis-
cule fraction of additional processing time. But if you stuff too many settings in an individual
GPO, the time to debug should things go wrong goes up exponentially. Group Policy has so
many nooks and crannies that it can be difficult to debug.

So, in a nutshell, if you have multiple GPOs at a particular level, you can do the following:
. Name each of them more descriptively.

. Debug them easily if things go wrong.

. Disable individually misbehaving GPOs.

=  Associate that GPO more easily to a WMI filter (explored in Chapter 5).

Ll More easily delegate permissions to any specific GPO (explored in Chapter 4).

If you have fewer GPOs at a particular level, the following is the case:

. Logging on is slightly faster for the user (but really only slightly).

. Debugging is somewhat more difficult if things go wrong.

=  You can disable individually misbehaving GPOs or links to misbehaving GPOs. (But if
they contain many settings, you might be disabling more than you desire.)

So, how do you form a GPO strategy? There is no right or wrong answer; you need to decide
what'’s best for you. Several options, however, can help you decide.

One middle-of-the-road strategy is to start with multiple GPOs and one lone policy setting in
each. Once you are comfortable that they are individually working as expected, you can create
another new GPO that contains the sum of the settings from, in this example, Hide Settings
Tab and Prohibit Access to Control Panel and then delete (or disable) the old individual GPO.

Another middle-of-the-road strategy is to have a single GPO that contains only the policy set-
tings required to perform a complete “wish.” This way, if the wish goes sour, you can easily
address it or disable it (or whack it) as needed.

- @
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First, you’ll need to create the new GPO and modify the settings. You’ll then need to move
some client machines into the Human Resources Computers OU in order to see your changes
take effect.

To auto-launch calc.exe for anyone logging into a computer in the Human Resources
Computers OU, follow these steps:

1. Ifyou’re not already logged in as Frank Rizzo, the Human Resources OU administrator,
do so now on VISTAMANAGEMENT.

Choose Start and type GPMC.MSC in the Start Search prompt.

Drill down until you reach the Human Resources Computers OU, right-click it, and
choose “Create a GPO in this domain, and Link it here” from the shortcut menu.

Name the GPO something descriptive, such as “Auto-Launch calc.exe.”

Right-click the GPO, and choose Edit to open the Group Policy Management Editor.
We want to affect our client computers (not users), so we need to use the Computers node.
To auto-launch calc.exe, drill down through Computer Configuration » Policies »
Administrative Templates » System » Logon, and double-click Run these programs at
user logon. Change the setting from Not Configured to Enabled.

7. Click the Show button, and the Show Contents dialog appears. Click Add and in the “Add
item” dialog, enter the full path to calc.exe as c:\windows\system32\calc.exe then
click OK as shown in Figure 1.29. Click OK to close the Show Contents dialog, and click
OK again to close the “Run these programs at user logon” policy setting.

8. Close the Group Policy Management Editor to return the GPMC.

a policy to disable a setting. Since Windows 2003, most policy settings have
been renamed to “Prohibit <whatever>" to reflect the change from confusion
to clarity.

% Be aware of occasional strange Microsoft verbiage when you need to enable
P

Moving Computers into the Human Resources
Computers OU

Since you just created a policy that will affect computers, you’ll need to place a workstation
or two inside the Human Resources Computers OU to see the results of your labor. You’ll
need to be logged on as Administrator to DCO1 to do this.

Quite often computers and users are relegated to separate OUs. That way,
P certain GPOs can be applied to certain computers but not others. For instance,
isolating laptops, desktops, and servers is a common practice.

In this example, we’re going to use the Find command in Active Directory Users and Com-

puters to find a workstation named XPPRO1 and the Windows Vista workstation named
VISTA1 and move it into the Human Resources Computers OU.

%
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At this point, take a minute to flip back to Figure 1.13 (the swimming pool illustration) to
see where we’re going here. To see the accumulation of your policy settings inside your GPOs,
you’ll need to log on as a user who is affected by the Human Resources Users OU and at a
computer that is affected by the Human Resources Computers OU. Therefore, log on as Frank
Rizzo on XPPRO1.

If you’re using Windows XP, right-click the Desktop and choose Display from the shortcut
menu to open the Display Properties dialog box. Note that the Settings tab is still missing from
the previous exercise (and the Screen Saver tab is restored). You should also see Windows Cal-
culator jumping at you as soon as you log on (because your computer GPO told it to).

If you’re using Windows Vista, right-click the Desktop and choose Personalize. Note that
the Desktop Settings option is still missing from the previous exercise (and the Screen Saver
entry is restored). And, when you logged in, did the computer GPO auto-launch Windows

Calculator?
< These tests prove that even OU administrators are not automatically immune
P from GPOs and the policy settings within. Under the hood, they are in the

Authenticated Users security group. See Chapter 4 for information on how to
modify this behavior.

The Three Possible Settings: Not Configured, Enabled, and Disabled

As you saw in Figure 1.18 earlier in this chapter, nearly all administrative template policy set-
tings can be set as Not Configured, Enabled, or Disabled. These three settings have very dif-
ferent consequences, so it's important to understand how each works.

Not Configured The best way to think about Not Configured is to imagine that it really says,
“Don’t do anything” or even “Pass through.” Why is this? Because if a policy setting is set to
Not Configured, then it honors any previously set setting (or, the operating system default).

Enabled When a specific policy setting is enabled, the policy will take effect. In the case of
the Hide Screen Saver Tab policy setting, the effect is obvious. However, lots of policy set-
tings, once enabled, have myriad possibilities inside the specific policy setting! (For a gander
at one such policy setting, use the Group Policy Management Editor and drill down to User
Configuration » Policies » Administrative Templates » Windows Components » Internet
Explorer > Toolbars and select the policy setting named Configure Toolbar Buttons.) So, as
we can see, Enabled really means “Turn this policy setting on.” Either it will then do what it
says or there will be more options inside the policy setting that can be configured.

Disabled This setting leads a threefold life.

= Disabled usually means that if the same policy setting is enabled at a higher level,
reverse its operation. For example, we chose to enable the Hide Screen Saver Tab pol-
icy setting at the site level. If at a lower level (say, the domain or OU level), we chose
to disable this policy setting, the Screen Saver tab will pop back at the level at which
we disabled this policy.

- @
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= Additionally, Disabled often forces the user to accept the administrator’s will. That is,
if a policy setting is disabled, some default behavior of the policy setting is enforced
and the user cannot change it. To see an example policy setting like this, use the
Group Policy Management Editor and drill down through User Configuration > Poli-
cies » Administrative Templates > Control Panel and select the policy setting named
Force classic Control Panel Style. Once this policy setting is disabled, the policy forces
Windows XP users to use the Control Panel in the new task-based style. The point here
is that the Disabled setting is a bit tricky to work with. You’ll want to be sure that when
you disable a policy setting, you're doing precisely what you intend.

= Disabled sometimes has a special and, typically, rare use. That is, something might

already be hard-coded into the Registry to be “turned on” or work one way, and the only
way to turn it off is to select Disabled. One such policy setting is the Shutdown Event

Tracker. You disable the policy setting, which turns it off, because on Windows 2003 and
Windows Server 2008 it’s already hard-coded on. In Windows XP and Windows Vista, it's
already hard-coded off. Likewise, if you want to kill Windows XP/SP2’s or Windows Vista’s
firewall, you need to set Windows Firewall: Protect All Network Connections to Disabled.
(You can find that policy setting at Computer Configuration > Policies » Administrative
Templates » Network > Network Connections > Windows Firewall > Domain Profile (and
also Standard Profile) while editing GPOs on Windows XP/Service Pack 2 and above.)

So, think of Not Configured as having neither Allow nor Deny being set. Enabled will turn iton and
possibly have more functions. Disabled has multiple uses, and be sure to test, test, test to make
sure that once you've manipulated a policy setting, it's doing precisely what you had in mind.

Final Thoughts

The concepts here are valid regardless of what your domain is running. It doesn’t matter if you
have a pure or mixed Active Directory domain with Windows 2000, Windows 2003, or Win-
dows Server 2008 Domain Controllers. The point is that to make the best use of Group Policy,
you’ll need an Active Directory.

You’ll also need a Vista management station to do the work. Again, we talk more about
why you need a Windows Vista management station in Chapters 3, 7, and 10.

I know it’s a little confusing to hear that the GPMC is built into Windows Vista only to be
taken away with Windows Vista + SP1. But don’t worry; you can grab it again from Microsoft
within the RSAT tools in a jiffy.

The more you use and implement GPOs in your environment, the better you’ll become at
their basic use while at the same time avoiding pitfalls when it comes to using them. The fol-
lowing tips are scattered throughout the chapter but are repeated and emphasized here for
quick reference, to help you along your Group Policy journey:

GPOs don’t “live” at the site, domain, or OU level. GPOs “live” in Active Directory and
are represented in the swimming pool of the domain called the Group Policy Objects con-
tainer. To use a GPO, you need to link a GPO to a level in Active Directory that you want to
affect: a site, a domain, or an OU.

- @
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GPOs apply to Active Directory sites, domains, and OUs. Active Directory is a hierarchy,
and Group Policy takes advantage of that hierarchy. There is one local GPO that can be set,
which affects everyone who uses that machine. Then, Active Directory Group Policy Objects
apply: site, domain, and then OU. Active Directory GPOs “trump” any local policy settings
if set within the Local Group Policy.

Avoid using the site level to implement GPOs. Users can roam from site to site by jumping
on different computers (or plugging their laptop into another site). When they do, they can be
confused by the settings changing around them. Use GPOs linked to the site only to set up special
sitewide security settings, such as IPsec or the Internet Explorer Proxy. Use the domain or OU
levels when creating GPOs whenever possible.

Implement common settings high in the hierarchy when possible. The higher up in the hier-
archy GPOs are implemented, the more users they affect. You want common settings to be set
once, affecting everyone, instead of having to create additional GPOs performing the same
functions at other lower levels, which will just clutter your view of Active Directory with the
multiple copies of the same policy setting.

Implement unique settings low in the hierarchy. If a specific collection of users is unique, try
to round them up into an OU and then apply Group Policy to them. This is much better than
applying the settings high in the hierarchy and using Group Policy filtering later.

Use more GPOs at any level to make things easier. When creating a new wish, isolate it by
creating a new GPO. This will enable easy revocation by unlinking it should something go awry.

Strike a balance between having too many and too few GPOs. There is a middle ground
between having one policy setting within a single GPO and having a bajillion policy settings
contained within a single GPO. At the end of your design, the goal is to have meaningfully
named GPOs that reflect the “wish” you want to accomplish. If you should choose to end that
wish, you can easily disable or delete it.

As you go on your Group Policy journey... Don’t go at it alone. There are some nice third-
party independent resources to help you on your way. I run www.GPanswers . com, which has
oodles of resources, downloads, a community forum, downloadable eChapters, video tutori-
als, links to third-party software, and my in-person hands-on training seminars. Think of it as
your secret Group Policy resource.

My pal (and technical editor for the previous edition) Darren Mar-Elia runs www.GPOguy . com.

My pal (and technical editor for this edition of the book) Jakob Heidelberg has a lot of great
articles (mostly on Group Policy topics) at http://www.windowsecurity.com/Jakob_H_
Heidelberg (http://tinyurl.com/ypar82).

There’s also Microsoft’s independent Group Policy Wiki at http://grouppolicy.editme
.com/. All of these locations are here to help you get more advanced with Group Policy as
you progress.




